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INTRODUCTION 

This guide is for individuals assigned the tasks of configuring a 

database for a WinSPC implementation, installing WinSPC and 

configuring WinSPC.  It consists of procedures to accomplish these 

tasks for each of the following platforms: 

� InterBase 6 

� Microsoft SQL Server 2000 

� Microsoft SQL Server 2005 Express 

� Microsoft SQL Server 2005 

� Oracle9i  

� Oracle 10g 

(Microsoft SQL Server 2005 Express is a free database server and may 

be downloaded from www.winspc.com.) 

WinSPC is certified to run both in a traditional client/server 

environment and a Microsoft Terminal Services environment.  The 

content in this guide applies to both except where marked by the 

Terminal Services marker, in which case the content applies uniquely 

to a Microsoft Terminal Services environment.  The first appearance 

of the Terminal Services marker is to the right of the following 

paragraph. 

When an implementation involves a Microsoft Terminal Services 

environment, WinSPC must be installed on the Microsoft Terminal 

Services server.  If the implementation does not also involve a 

client/server environment, make the Microsoft Terminal Services 

server your first client.  First client simply refers to the first computer 

on which WinSPC is installed.  If the implementation also involves a 

client/server environment, it does not matter whether you make the 
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Microsoft Terminal Services server the first client or an additional 

client.  Additional client means any computer on which WinSPC is 

installed other than the first client.  Electing to make the Microsoft 

Terminal Services server the first client means that the procedure for 

installing WinSPC on the Microsoft Terminal Services server is the 

procedure detailed in Phase 2 of the chapter specific to the database 

server being used in your implementation.  Electing to make the 

Microsoft Terminal Services server an additional client means that the 

procedure for installing WinSPC on the Microsoft Terminal Services 

server is the procedure detailed in Chapter 7: Additional Client 

Installs and Configurations. 

For WinSPC’s hardware requirements and recommended platforms, 

see Appendix G: Hardware Requirements and Recommended 

Platforms. 

DataNet Quality Systems wants your installation and configuration to 

be a positive experience.  Please do not hesitate to contact our Product 

Support Help Desk at (248)-447-0140 if you have questions 

concerning any of the information in this guide.
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CHAPTER 1: INTERBASE 6 

ASSUMPTIONS 

The instructions in this chapter are based on the following 

assumptions: 

� InterBase 6 Server is installed and running on your database 

server. 

� InterBase 6 Client is installed on your database server. 

� The default values presented by InterBase 6 Server and InterBase 6 

Client during the installation process were accepted without 

modification. 

� Any firewalls between your database server and the client 

machines to be used for WinSPC are properly configured to permit 

database traffic. 

� For implementations employing a Microsoft Terminal Services 

environment, Microsoft Terminal Services is properly installed and 

configured on the server designated as your Microsoft Terminal 

Services server. 

� The operating system of your database server machine is Windows 

2003 Server. 

� The operating system of the client machines to be used for 

WinSPC is Windows XP Pro. 

NOTE: If a default value was modified during the installation of 

InterBase 6 or an operating system is different from that 

stated here, adapt the instructions in this guide as needed to 

accommodate the modified value or differing operating 

system. 
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SERVER CONFIGURATION 

Create and Share a Database File Folder 

1. On the InterBase 6 Server machine, create a folder in which the 

database file for WinSPC can be saved.  (The recommended path 

and name of this folder is: C:\IBData.) 

2. Share this folder and grant domain administrators a minimum of 

Change share permissions and Modify security permissions to it.  

(For a procedure on granting share or security permissions, see 

Appendix D: Granting Share and Security Permissions.) 

NOTE: If your WinSPC implementation is part of a workgroup 

rather than a domain, grant these Change and Modify 

permissions to the local administrator on the InterBase 6 

Server machine who will configure InterBase 6 and the 

local administrator who will be install and configure 

WinSPC on the first WinSPC client machine.  (See the 

First Client Install and Configuration (Initial Steps) 

section of this chapter for a definition of the first WinSPC 

client machine.) 

Phase 1 of 4 
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Register a Server 

1. From the InterBase 6 Server machine, click Start > All Programs 

> InterBase > IBConsole.   

2. In the IBConsole window that appears, from the Server menu, 

select Register. 
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3. In the Register Server and Connect window that is displayed: 

a. At User Name, enter SYSDBA. 

b. At Password, enter masterkey. 

c. Click OK. 

 

NOTE: The masterkey password entered in step b above is 

InterBase’s default password.  For security reasons, it is 

recommended you change this password. 
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This closes the Register Server and Connect dialog box and lists 

Local Server in the IBConsole window. 

 

Create a Database 

1. In the IBConsole window, from the Database menu, select Create 

Database. 
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2. In the Create Database dialog box that is displayed: 

a. At Alias, create and enter a name for the WinSPC database. 

(The recommended database name is WINSPC.) 

b. In the first empty Filenames(s) cell, create the filename for the 

database.  This filename is composed of two parts separated by 

a backslash: the path of the folder created in step 1 of this 

chapter’s Create and Share a Database File Folder section 

and the newly created alias with a .gdb extension (e.g. 

C:\IBData\winspc.gdb).  

c. At Default Character Set, select Win1252. 

d. At SQL Dialect, select 1. 

e. Click OK. 
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This creates the database and displays the database alias in the 

IBConsole window. 

Create a Server Login 

1. With the newly created database highlighted in the IBConsole 

window, from the Server menu, select User Security. 
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2. In the User Information dialog box that appears: 

a. Click New. 

b. At User Name, create and enter a user name for the login.  

(The recommended user name is JOHNDOE.) 

c. At Password, create and enter a sufficiently strong password 

for the login. 

d. At Confirm Password, reenter the password. 

e. Click Apply.  This adds the new user. 

f. Click Close. 

 



Chapter 1: InterBase 6 

  Installation and Configuration Guide 11 

NOTE: The user name and password entered here will be used by 

InterBase 6 to authentic WinSPC client machines and 

allow authenticated machines access to the WinSPC 

database.  This user name and password combination is 

not directly used by WinSPC users.  WinSPC users will, 

later, be assigned individual user IDs and passwords.  

They will use these individual user IDs and passwords to 

log into the WinSPC application on WinSPC client 

machines. 

3. From the IBConsole window, click Console > Exit.   

THIS COMPLETES PHASE 1 OF 4. 

GO TO THE NEXT PAGE AND COMPLETE PHASE 2. 
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Phase 2 of 4 

  
 

FIRST CLIENT INSTALL AND CONFIGURATION (INITIAL STEPS) 

This section concerns the installation and configuration of WinSPC on 

the first WinSPC client machine.  The first WinSPC client machine 

simply refers to the first computer on which you want to install 

WinSPC.  This computer can be any machine on your network. 

If your implementation employs Microsoft Terminal Services, see the 

discussion on page 1 of this guide for direction on whether to make 

your first client the Microsoft Terminal Services server or another 

computer.   

1. Create a folder on a network file server accessible by all client 

machines that will run WinSPC.  This folder’s primary purpose is 

to facilitate the installation and configuration of WinSPC on all 

clients other than the first client.  (The recommended name for this 

folder is WinSPCRemote.) 

2. Share this folder and grant domain administrators a minimum of 

Change share permissions and Modify security permissions to it.  

(For a procedure on granting share or security permissions, see 

Appendix D: Granting Share and Security Permissions.) 

NOTE: If your WinSPC implementation is part of a workgroup 

rather than a domain, grant these Change and Modify 

permissions to the local administrator who will install and 

configure WinSPC on the first WinSPC client machine. 

3. Log into Windows on the first WinSPC client machine as a domain 

administrator who also has local administrator privileges. 

NOTE: If the first WinSPC client machine is part of a workgroup 

instead of a domain, log in as a local administrator. 
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4. Insert the WinSPC CD into the first WinSPC client’s CD-ROM 

drive.  If autorun is enabled on the client, the CD will start 

automatically.  If autorun is not enabled: 

a. Click Start > My Computer. 

b. In the My Computer dialog box, double-click your CD-ROM 

drive. 

c. When the list of files appears, double-click Setup.exe. 

5. When the WinSPC Setup screen appears, click Install WinSPC. 

6. Install WinSPC by following the setup prompts.  During this 

installation, after the step when programs files are copied, close the 

folder that automatically opens.  When the Setup Complete screen 

appears, click Finish. 

NOTE: The setup prompts are intended to be self-explanatory.  

Consequently, they are not detailed here.  If you have a 

question about a prompt or want to be directed step-by-

step through the setup wizard, see Appendix A: WinSPC 

Setup Prompts. 

7. Complete Appendix B: Installing NJWin for an Asian 

Language if the first client machine will need to run WinSPC in 

an Asian language or you would like to run the Initial System 

Setup Wizard in an Asian language.  (The Initial System Setup 

Wizard is the tool you will use next in this first client configuration 

process.) 

8. Exit the WinSPC Setup screen by clicking the X in the upper right 

corner. 

9. Remove the WinSPC CD from the CD-ROM drive. 



Chapter 1: InterBase 6 

14 Installation and Configuration Guide 

10. Run WinSPC.  The default path for doing this is Start > All 

Programs > WinSPC > WinSPC CS.  This launches the Initial 

System Setup Wizard. 

11. On the Language screen, from the Select language list, choose a 

language and click Next. 

 

NOTE: The language selected here becomes the language in 

which the remainder of the Initial System Setup Wizard 

will be run.  It also becomes the system-wide default 

language for WinSPC.  (This default language can be 

changed at any time following the completion of the 

Initial System Setup Wizard.  See the Help in WinSPC 

for information on default languages once the 

configuration of the first WinSPC client is complete.) 
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12. On the Database Server Type screen, select InterBase 6 Server 

and click Next.  (Notice this screen is displayed in the language 

selected during the preceding step.) 
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13. On the InterBase Server Settings screen, if the network protocol 

to be used for communication with your InterBase 6 Server 

machine is NetBEUI, select NetBEUI, click Next and go to step 

14.  If the protocol is TCP/IP, select TCP/IP, click Next and go to 

step 15. 
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14. If NetBEUI was selected in step 13, on the next InterBase Server 

Settings screen:   

a. Leave the Machine Name field blank. 

b. At Database Path, click Browse and, in the Open screen that 

appears, navigate to and double-click the filename created in 

step 2b of this chapter’s Create a Database section.   

c. Click Next. 
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15. If TCP/IP was selected in step 13, on the next InterBase Server 

Settings screen: 

a. At Machine Name, enter the name of your InterBase 6 Server 

machine. 

b. At Database Path, enter the database path and filename 

created in step 2b of this chapter’s Create a Database section.  

c. Click Next. 
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16. On the Database Server Log In screen, enter the server User 

Name and Password created in this chapter’s Create a Server 

Login section and click Next. 
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17. On the Database Communications Test screen, click Next. 

 

NOTE: In the event the test fails: 

� If the error message displayed reads Unknown 

database.  Unable to complete network request to 

host…, click the Back button three times and reenter 

the machine name, ensuring you have the correct 

name and that it is spelled correctly.  Once you’ve 

reentered this information, advance through the Initial 

System Setup Wizard again by clicking Next, 

verifying the information on each screen as you do. 
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� If the error message displayed reads Unknown 

database.  I/O error for file…, click the Back 

button three times and reenter the database path, 

ensuring you have the correct path and that it is 

spelled correctly.  Once you’ve reentered this 

information, advance through the Initial System Setup 

Wizard again by clicking Next, verifying the 

information on each screen as you do. 

� If the error message reads Unknown database.  Your 

user name and password are not defined…, click 

the Back button twice and reenter the server user 

name and password, ensuring you have the correct 

user name and password and that these are spelled 

correctly.  Also, since passwords are case sensitive, 

ensure the appropriate capitalization is used for the 

password.  Once you’ve reentered this information, 

advance through the Initial System Setup Wizard 

again by clicking Next, verifying the information on 

each screen as you do. 
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18. On the Database Creation screen, click Next.  This creates the 

WinSPC schema within the WinSPC database. 
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19. If you selected a language other than English in step 11 of this 

section, an Add Language screen appears once the WinSPC 

schema is created.  In this case: 

a. Insert the language disk for the selected language into your 

floppy drive and click the OK button.  

b. In the message asking if you want to proceed with the addition 

of the detected language, click OK. 

c. If a message indicating the detected language has already been 

installed appears, click OK. 

d. Allow the Adding New Language progress bar to complete. 

e. When the You may now select the desired language in the 

System Settings, Station Setup, or User Setup message 

appears, click OK. 

f. If the Add Language screen reappears, click Cancel. 

g. Remove the language disk from the floppy drive. 

NOTE: Language disks are included in your WinSPC materials.  

If you didn’t order a language disk and, consequently, did 

not receive one, click the Cancel button and complete the 

Initial System Setup Wizard without adding the language.  

Later, you can order the language disk and, once it 

arrives, add the language using the Add Language option 

on the Administrator window’s Tools menu in WinSPC.  

Until the language is added, you’ll be restricted to 

running WinSPC in English.  (The remainder of the 

Initial System Setup Wizard continues to run in the 

selected language whether or not a language is added 

from a language disk.) 
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THIS COMPLETES PHASE 2 OF 4. 

GO TO CHAPTER 6: FIRST CLIENT 

CONFIGURATION (FINAL STEPS) AND 

COMPLETE PHASE 3. 
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CHAPTER 2: MICROSOFT SQL SERVER 2000 

ASSUMPTIONS 

The instructions in this chapter are based on the following 

assumptions: 

� The Default instance of the Microsoft SQL Server 2000 database 

server software is installed and running on your database server 

machine and you have been authorized to use this instance for your 

WinSPC implementation. 

� During the installation of this Default instance, the setup type 

specified was Typical and the authentication mode selected was 

Mixed Mode (Windows Authentication and SQL Server 

Authentication).  (WinSPC will not function if the default 

Windows Authentication Mode was accepted.) 

� Microsoft SQL Server 2000 client tools are installed on your 

database server. 

� Microsoft SQL Server 2000 Service Pack 3a is installed on your 

database server.  (During the installation of this service pack, the 

Mixed Mode of authentication was selected.) 

� Other than the Mixed Mode of authentication, the default values 

presented by Microsoft SQL Server 2000 during the installation 

process were accepted without modification.   

� Any firewalls between your database server and the client 

machines to be used for WinSPC are properly configured to permit 

database traffic. 

� For implementations employing a Microsoft Terminal Services 

environment, Microsoft Terminal Services is properly installed and 

configured on the server designated as your Microsoft Terminal 

Services server.  
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� The operating system of your database server machine is Windows 

2003 Server. 

� The operating system of the client machines to be used for 

WinSPC is Windows XP Pro. 

NOTE: If a default value was modified during the installation of 

Microsoft SQL Server 2000 or an operating system is 

different from that stated here, adapt the instructions in this 

guide as needed to accommodate the modified value or 

differing operating system. 
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SERVER CONFIGURATION 

Establish a Server Connection 

1. On the database server, click Start > All Programs > Microsoft 

SQL Server > Enterprise Manager. 

2. In the left pane of the SQL Server Enterprise Manager that 

opens, expand Microsoft SQL Servers > SQL Server Group, 

right-click (LOCAL) (Windows NT) and select Edit SQL Server 

Registration properties.   

 

Phase 1 of 4 
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3. In the Registered SQL Server Properties dialog box: 

a. Under Connection, select Use SQL Server authentication. 

b. At Login Name, enter sa. 

c. At Password, enter the SQL Server authentication password 

created during the installation of Microsoft SQL Server 2000. 

d. Click OK.  This establishes a connection to the server and 

closes the Registered SQL Server Properties dialog box. 
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Create a Database 

1. In the right pane of the SQL Server Enterprise Manager, right-

click the Databases folder and, from the shortcut menu, select 

New Database. 
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2. In the Database Properties dialog box that is displayed, at Name, 

create and enter a name for the database and click OK.  (The 

recommended name is WINSPC.) 
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Create a Server Login 

1. In the left pane of the SQL Server Enterprise Manager, under 

the (LOCAL) (Windows NT) server, expand Security, right-click 

Logins and, from the shortcut menu, select New Login. 
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2. In the SQL Server Login Properties - New Login dialog box, on 

the General tab: 

a. At Name, create and enter a name for the login.  (The 

recommended user name is JOHNDOE.) 

b. Under Authentication, select SQL Server authentication. 

c. At Password, create and enter a sufficiently strong password 

for the login. 

NOTE: The user name and password entered here will be used by 

Microsoft SQL Server 2000 to authentic WinSPC client 

machines and allow authenticated machines access to the 

WinSPC database.  This user name and password 

combination is not directly used by WinSPC users.  

WinSPC users will, later, be assigned individual user IDs 

and passwords.  They will use these individual user IDs 

and passwords to log into the WinSPC application on 

WinSPC client machines. 
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d. Under Defaults, at Database, select WinSPC. 
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3. Without clicking OK, click the Database Access tab and on this 

tab: 

a. In the upper pane, check the check box for the WinSPC 

database. 

b. In the lower pane, check the check box for the db_owner role. 

c. Click OK. 
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4. In the Confirm Password dialog box, at Confirm new password, 

enter the login password created in step 2c and click OK. 

 

This causes the login name to be listed in the right pane of the 

SQL Server Enterprise Manager. 
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5. In the left pane, under (LOCAL) (Windows NT), expand 

Databases, right-click the newly created database and, from the 

shortcut menu, select Properties.   
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6. In the <Database Name> Properties dialog box, click the 

Permissions tab. 

 



Chapter 2: Microsoft SQL Server 2000 

38 Installation and Configuration Guide 

7. In the Create Table column, check the check box for the new 

server login name and click OK.  This closes the <Database 

Name> Properties dialog box. 

 

8. Close the SQL Server Enterprise Manager. 

THIS COMPLETES PHASE 1 OF 4. 

GO TO THE NEXT PAGE AND COMPLETE PHASE 2. 
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Phase 2 of 4 

  
 

FIRST CLIENT INSTALL AND CONFIGURATION (INITIAL STEPS) 

This section concerns the installation and configuration of WinSPC on 

the first WinSPC client machine.  The first WinSPC client machine 

simply refers to the first computer on which you want to install 

WinSPC.  This computer can be any machine on your network. 

If your implementation employs Microsoft Terminal Services, see the 

discussion on page 1 of this guide for direction on whether to make 

your first client the Microsoft Terminal Services server or another 

computer.   

1. Create a folder on a network file server accessible by all client 

machines that will run WinSPC.  This folder’s primary purpose is 

to facilitate the installation and configuration of WinSPC on all 

clients other than the first client.  (The recommended name for this 

folder is WinSPCRemote.) 

2. Share this folder and grant domain administrators a minimum of 

Change share permissions and Modify security permissions to it.  

(For a procedure on granting share or security permissions, see 

Appendix D: Granting Share and Security Permissions.) 

NOTE: If your WinSPC implementation is part of a workgroup 

rather than a domain, grant these Change and Modify 

permissions to the local administrator who will install and 

configure WinSPC on the first WinSPC client machine. 

3. Log into Windows on the first WinSPC client machine as a domain 

administrator who also has local administrator privileges. 

NOTE: If the first WinSPC client machine is part of a workgroup 

instead of a domain, log in as a local administrator. 
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4. Insert the WinSPC CD into the first WinSPC client’s CD-ROM 

drive.  If autorun is enabled on the client, the CD will start 

automatically.  If autorun is not enabled: 

a. Click Start > My Computer. 

b. In the My Computer dialog box, double-click your CD-ROM 

drive. 

c. When the list of files appears, double-click Setup.exe. 

5. When the WinSPC Setup screen appears, click Install WinSPC. 

6. Install WinSPC by following the setup prompts.  During this 

installation, after the step when programs files are copied, close the 

folder that automatically opens.  When the Setup Complete screen 

appears, click Finish. 

NOTE: The setup prompts are intended to be self-explanatory.  

Consequently, they are not detailed here.  If you have a 

question about a prompt or want to be directed step-by-

step through the setup wizard, see Appendix A:  

WinSPC Setup Prompts. 

7. Complete Appendix B: Installing NJWin for an Asian 

Language if the first client machine will need to run WinSPC in 

an Asian language or you would like to run the Initial System 

Setup Wizard in an Asian language.  (The Initial System Setup 

Wizard is the tool you will use next in this first client configuration 

process.) 

8. Exit the WinSPC Setup screen by clicking the X in the upper right 

corner. 

9. Remove the WinSPC CD from the CD-ROM drive. 
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10. Run WinSPC.  The default path for doing this is Start > All 

Programs > WinSPC > WinSPC CS.  This launches the Initial 

System Setup Wizard. 

11. On the Language screen, from the Select language list, choose a 

language and click Next. 

 

NOTE: The language selected here becomes the language in 

which the remainder of the Initial System Setup Wizard 

will be run.  It also becomes the system-wide default 

language for WinSPC.  (This default language can be 

changed at any time following the completion of the 

Initial System Setup Wizard.  See the Help in WinSPC 

for more information on default languages once the 

configuration of the first WinSPC client is complete.) 
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12. On the Database Server Type screen, select Microsoft SQL 

Server 2000 and click Next.  (Notice this screen is displayed in the 

language selected during the preceding step.) 
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13. On the Microsoft SQL Server Settings screen: 

a. At Machine Name, enter the machine name and instance name 

for the Microsoft SQL Server 2000 instance designated for 

WinSPC, separating these two names by a backslash (e.g. 

Testserver\WinSPC). 

NOTE: If the Microsoft SQL Server 2000 instance designated 

for WinSPC is the only Microsoft SQL Server 2000 

instance installed on the server, it is not necessary to 

enter the instance name. 

b. At Database Name, enter the database name you created in 

step 2 of this chapter’s Create a Database section. 

c. Click Next. 
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14. On the Database Server Log In screen, enter the server User 

Name and Password created in step 2 of this chapter’s Create a 

Server Login section and click Next. 
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15. On the Database Communications Test screen, click Next. 

 

NOTE: In the event the test fails: 

� If the error message displayed reads Cannot locate 

or connect to SQL Server.  Unable to connect…, 

click the Back button three times and reenter the 

machine and instance names, ensuring you have the 

correct names and that they are spelled correctly.  

Once you’ve reentered this information, advance 

through the Initial System Setup Wizard again by 

clicking Next, verifying the information on each 

screen as you do.   
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� If the error message displayed reads General SQL 

error.  Could not locate entry…, click the Back 

button three times and reenter the database name, 

ensuring you have the correct name and that it is 

spelled correctly.  Once you’ve reentered this 

information, advance through the Initial System Setup 

Wizard again by clicking Next, verifying the 

information on each screen as you do. 

� If the error message reads Unknown user name or 

password,  Login failed…, click the Back button 

twice and reenter the server user name and password, 

ensuring you have the correct user name and 

password and that these are spelled correctly.  Also, 

since passwords are case sensitive, ensure the 

appropriate capitalization is used for the password.  

Once you’ve reentered this information, advance 

through the Initial System Setup Wizard again by 

clicking Next, verifying the information on each 

screen as you do. 
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16. On the Database Creation screen, click Next.  This creates the 

WinSPC schema within the WinSPC database. 
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17. If you selected a language other than English in step 11 of this 

section, an Add Language screen appears once the WinSPC 

schema is created.  In this case: 

a. Insert the language disk for the selected language into your 

floppy drive and click the OK button.   

b. In the message asking if you want to proceed with the addition 

of the detected language, click OK. 

c. If a message indicating the detected language has already been 

installed appears, click OK. 

d. Allow the Adding New Language progress bar to complete. 

e. When the You may now select the desired language in the 

System Settings, Station Setup, or User Setup message 

appears, click OK.   

f. If the Add Language screen reappears, click Cancel. 

g. Remove the language disk from the floppy drive. 

NOTE: Language disks are included in your WinSPC materials.  

If you didn’t order a language disk and, consequently, did 

not receive one, click the Cancel button and complete the 

Initial System Setup Wizard without adding the language.  

Later, you can order the language disk and, once it 

arrives, add the language using the Add Language option 

on the Administrator window’s Tools menu in WinSPC.  

Until the language is added, you’ll be restricted to 

running WinSPC in English.  (The remainder of the 

Initial System Setup Wizard continues to run in the 

selected language whether or not a language is added 

from a language disk.)  
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THIS COMPLETES PHASE 2 OF 4. 

GO TO CHAPTER 6: FIRST CLIENT 

CONFIGURATION (FINAL STEPS) AND 

COMPLETE PHASE 3. 
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CHAPTER 3: MICROSOFT SQL SERVER 2005 

& 2005 EXPRESS 

WinSPC is certified to run on both Microsoft SQL Server 2005 and 

Microsoft SQL Server 2005 Express. This chapter applies to both of these 

editions. 

Because the procedures to configure these editions for use with WinSPC are 

nearly identical, where Microsoft SQL Server screen images are used to 

illustrate this chapter, they are exclusively from Microsoft SQL Server 2005 

Express. In addition, where the text of this chapter applies to both editions 

equally, edition-specific titles are omitted in favor of generic titles such as 

Microsoft SQL Server or SQL Server Management Studio. 

ASSUMPTIONS 

The instructions in this chapter are based on the following 

assumptions: 

� For Microsoft SQL Server 2005 Express, the version of WinSPC 

which will be installed and configured is 7.2.10 or later. (Microsoft 

SQL Server 2005 has been certified for use with WinSPC since 

WinSPC Version 7.1.) 

� The edition of Microsoft SQL Server you want to use for your 

WinSPC implementation is installed and running on your database 

server machine. 

� An instance of this edition has been created for WinSPC and is 

running. (This instance may be named or unnamed.) 

� During the creation of this instance, the authentication mode 

selected was Mixed Mode (Windows Authentication and SQL 

Server Authentication).  (WinSPC will not function if the default 

Windows Authentication Mode was accepted.) 
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� The management and configuration tools appropriate to your 

edition of Microsoft SQL Server are installed on your database 

server. At a minimum, these include SQL Server Management 

Studio and SQL Server Configuration Manager. 

� Other than the Mixed Mode of authentication, the default values 

presented by Microsoft SQL Server during the setup process were 

accepted without modification. 

� Any firewalls between your database server and the client 

machines to be used for WinSPC are properly configured to permit 

database traffic. 

� For implementations employing a Microsoft Terminal Services 

environment, Microsoft Terminal Services is properly installed and 

configured on the server designated as your Microsoft Terminal 

Services server. 

� The operating system of your database server machine is Windows 

2003 Server. 

� The operating system of the client machines to be used for 

WinSPC is Windows XP Pro. 

NOTE: If a default value was modified during the installation of 

Microsoft SQL Server or an operating system is different 

from that stated here, adapt the instructions in this guide as 

needed to accommodate the modified value or differing 

operating system. 
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SERVER CONFIGURATION 

Establish a Server Connection 

1. On the database server machine, launch SQL Server 

Management Studio, the default path for which is Start > All 

Programs > Microsoft SQL Server > SQL Server Management 

Studio. 

2. In the Connect to Server dialog box that appears: 

a. At Server Type, accept the Database Engine default. 

b. At Server name, if a name is not displayed or the name 

displayed is incorrect for your WinSPC implementation, select 

the correct name from the dropdown list. Depending on your 

edition of Microsoft SQL Server and the options selected 

during this edition’s setup, the instance for your 

implementation may be named or unnamed. If your instance is 

named, the correct name for this Server name field consists of 

a combination of the server name and the instance name (e.g. 

TESTSERVER\SQLEXPRESS). If your instance is unnamed, 

the correct name for this Server name field consists of the 

server name alone (e.g. TESTSERVER). In the event the server 

name displayed is incorrect and the dropdown list does not 

contain the correct name: 

i. From the Server name dropdown list, select <Browse for 

more…>. 

ii. In the Browse for Servers dialog box, click the Network 

Servers tab. This automatically initiates a search for 

servers on your network. 

Phase 1 of 4 
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iii. When the search completes, expand Database Engine and 

single-click the desired server name or server 

name\instance name combination. 

iv. Click OK. 

c. At Authentication, select SQL Server Authentication. 

d. At Login, enter sa. 

e. At Password, enter the password assigned to the sa login. 

f. Click Connect. 

 

NOTE: If the Connect to Server dialog box is not displayed, 

click File > New > Database Engine Query and 

complete the preceding substeps in the Connect to 

Database Engine dialog box. 
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Create a Database 

1. In the Object Explorer (i.e. the left pane) of Microsoft SQL 

Server Management Studio, right-click Databases and, from the 

shortcut menu, select New Database. 

 



Chapter 3: Microsoft SQL Server 2005 and 2005 Express 

56 Installation and Configuration Guide 

2. In the New Database dialog box, at Database name, create and 

enter a name for the database.  (The recommended database name 

is WinSPC.) 

 

3. In the top left of the dialog box, under Select a Page, click 

Options. 
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4. At Compatibility Level, select SQL Server 2000 (80) and click 

OK. The New Database dialog box closes. 
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Create a Server Login 

1. In the Object Explorer, right-click the Security folder and select 

New > Login. 

 

(The Security folder referred to here is the one in the root level of 

the folder for the server or server\instance you are configuring, not 

the Security sub-folder within the new Databases folder.) 
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2. In the Login - New dialog box: 

a. At Login name, create and enter a name for the login.  (The 

recommended name is JOHNDOE.) 

NOTE: The name entered here must match the schema name 

entered in step 3b below. 

b. Select SQL Server authentication. 

c. At Password, create and enter a sufficiently strong password 

for the login. 

d. At Confirm password, reenter the password. 

NOTE: The user name and password entered here will be used by 

Microsoft SQL Server to authentic WinSPC client 

machines and allow authenticated machines access to the 

WinSPC database.  This user name and password 

combination is not directly used by WinSPC users.  

WinSPC users will, later, be assigned individual user IDs 

and passwords.  They will use these individual user IDs 

and passwords to log into the WinSPC application on 

WinSPC client machines. 
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e. Uncheck the Enforce password policy check box. 

f. At Default database, select WinSPC.  

 



Chapter 3: Microsoft SQL Server 2005 and 2005 Express 

  Installation and Configuration Guide 61 

3. Under Select a page (top left pane), single-click User Mapping 

and then, in the right portion of the dialog box: 

a. Under Users mapped to this login, in the Map column, check 

the check box for the newly created WinSPC database. 

b. In the same row as the WinSPC database, click the empty 

Default Schema cell and, again, enter the login name created 

in step 2a. 

c. In the bottom half of the dialog box, under Database role 

membership for: <Database Name>, check the db_owner 

check box. 

d. Click OK. 
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Configure the SQL Server Browser Service and Enable a Network 

Protocol 

1. Without exiting Microsoft SQL Server Management Studio, 

launch SQL Server Configuration Manager, the default path for 

which is Start > All Programs > Microsoft SQL Server > 

Configuration Tools > SQL Server Configuration Manager. 

2. If the instance you are working with is not a named instance, you 

do not need to complete this step and may proceed to step 3. If the 
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instance you are working with is a named service, configure the 

SQL Browser Service to start automatically and then manually 

start the service. To do this: 

a. In the left pane of SQL Server Configuration Manager, click 

SQL Server Services. 

 

b. In the right pane, right-click SQL Server Browser and select 

Properties. 

c. In the SQL Server Browser Properties dialog box, click the 

Service tab. 

d. On this tab, to the right of Start Mode, click Disabled and 

select Automatic. 
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e. Click the Apply button. 

f. Click the Log On tab and on this tab click the Start button. 
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g. Allow the progress bar that appears to complete and click OK.  

3. Enable a network protocol. To do this: 

a. In the left pane of SQL Server Configuration Manager, 

expand SQL Server Network Configuration and single-click 

Protocols for <SERVER OR INSTANCE NAME>. 
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b. In the right pane, right-click either TCP/IP or Named Pipes 

and click Enable.  (WinSPC works with either of these 

options.  If you are unsure of which option to choose, consult 

with your network administrator.) 

 

c. In the warning indicating that changes will not take effect until 

the service is stopped and restarted, click OK. 

 

d. Close SQL Server Configuration Manager. 
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e. In Microsoft SQL Server Management Studio, right-click 

the server or server/instance you’ve been configuring and 

select Stop. 

 

f. In the message box that appears, click Yes to confirm you want 

to stop the service. 
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g. When the message box closes, right-click the server or 

server/instance again and select Start. 
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h. In the message box that appears, click Yes to confirm you want 

to start the service. 

 

i. Click File > Exit to close Microsoft SQL Server 

Management Studio. 

THIS COMPLETES PHASE 1 OF 4. 

GO TO THE NEXT PAGE AND COMPLETE PHASE 2. 
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Phase 2 of 4 

  
 

FIRST CLIENT INSTALL AND CONFIGURATION (INITIAL STEPS) 

This section concerns the installation and configuration of WinSPC on 

the first WinSPC client machine.  The first WinSPC client machine 

simply refers to the first computer on which you want to install 

WinSPC.  This computer can be any machine on your network.  

If your implementation employs Microsoft Terminal Services, see the 

discussion on page 1 of this guide for direction on whether to make 

your first client the Microsoft Terminal Services server or another 

computer.   

1. Create a folder on a network file server accessible by all client 

machines that will run WinSPC.  This folder’s primary purpose is 

to facilitate the installation and configuration of WinSPC on all 

clients other than the first client.  (The recommended name for this 

folder is WinSPCRemote.) 

2. Share this folder and grant domain administrators a minimum of 

Change share permissions and Modify security permissions to it.  

(For a procedure on granting share or security permissions, see 

Appendix D: Granting Share and Security Permissions.) 

NOTE: If your WinSPC implementation is part of a workgroup 

rather than a domain, grant these Change and Modify 

permissions to the local administrator who will install and 

configure WinSPC on the first WinSPC client machine. 

3. Log into Windows on the first WinSPC client machine as a domain 

administrator who also has local administrator privileges. 

NOTE: If the first WinSPC client machine is part of a workgroup 

instead of a domain, log in as a local administrator. 
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4. Insert the WinSPC CD into the first WinSPC client’s CD-ROM 

drive.  If autorun is enabled on the client, the CD will start 

automatically.  If autorun is not enabled: 

a. Click Start > My Computer. 

b. In the My Computer dialog box, double-click your CD-ROM 

drive. 

c. When the list of files appears, double-click Setup.exe. 

5. When the WinSPC Setup screen appears, click Install WinSPC. 

6. Install WinSPC by following the setup prompts.  During this 

installation, after the step when programs files are copied, close the 

folder that automatically opens.  When the Setup Complete screen 

appears, click Finish.  

NOTE: The setup prompts are intended to be self-explanatory.  

Consequently, they are not detailed here.  If you have a 

question about a prompt or want to be directed step-by-

step through the setup wizard, see Appendix A:  

WinSPC Setup Prompts.  

7. Complete Appendix B: Installing NJWin for an Asian 

Language if the first client machine will need to run WinSPC in 

an Asian language or you would like to run the Initial System 

Setup Wizard in an Asian language.  (The Initial System Setup 

Wizard is the tool you will use next in this first client configuration 

process.) 

8. Exit the WinSPC Setup screen by clicking the X in the upper right 

corner. 

9. Remove the WinSPC CD from the CD-ROM drive. 
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10. Run WinSPC.  The default path for doing this is Start > All 

Programs > WinSPC > WinSPC CS.  This launches the Initial 

System Setup Wizard. 

11. On the Language screen, from the Select language list, choose a 

language and click Next. 

 

NOTE: The language selected here becomes the language in 

which the remainder of the Initial System Setup Wizard 

will be run.  It also becomes the system-wide default 

language for WinSPC.  (This default language can be 

changed at any time following the completion of the 

Initial System Setup Wizard.  See the Help in WinSPC 

for more information on default languages once the 

configuration of the first WinSPC client is complete.) 
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12. On the Database Server Type screen, select your Microsoft SQL 

Server edition and click Next.  (Notice this screen is displayed in 

the language selected during the preceding step.) 
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13. On the Microsoft SQL Server Settings screen: 

a. At Machine Name, enter the machine name and instance name 

for the Microsoft SQL Server instance designated for WinSPC, 

separating these two names by a backslash (e.g. 

TESTSERVER\SQLEXPRESS).  

NOTE: If the instance designated for WinSPC is unnamed, 

enter the server name only. If you do not know 

whether the instance is named or unnamed or if you 

know the instance is named but are unsure of the 

name used, contact the server administrator. 

b. At Database Name, enter the database name you choose in 

step 2 of this chapter’s Create a Database section. 

c. Click Next. 
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14. On the Database Server Log In screen, enter the server User 

Name and Password created in step 2 of this chapter’s Create a 

Server Login section and click Next. 
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15. On the Database Communications Test screen, click Next. 

 

NOTE: In the event the test fails: 

� If the error message displayed reads Cannot locate 

or connect to SQL Server.  Unable to connect…, 

click the Back button three times and reenter the 

machine and instance names, ensuring you have the 

correct names and that they are spelled correctly.  

Once you’ve reentered this information, advance 

through the Initial System Setup Wizard again by 

clicking Next, verifying the information on each 

screen as you do. 
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� If the error message displayed reads General SQL 

error.  Could not locate entry…, click the Back 

button three times and reenter the database name, 

ensuring you have the correct name and that it is 

spelled correctly.  Once you’ve reentered this 

information, advance through the Initial System Setup 

Wizard again by clicking Next, verifying the 

information on each screen as you do. 

� If the error message reads Unknown user name or 

password.  Login failed…, click the Back button 

twice and reenter the server user name and password, 

ensuring you have the correct user name and 

password and that these are spelled correctly.  Also, 

since passwords are case sensitive, ensure the 

appropriate capitalization is used for the password.  

Once you’ve reentered this information, advance 

through the Initial System Setup Wizard again by 

clicking Next, verifying the information on each 

screen as you do. 
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16. On the Database Creation screen, click Next.  This creates the 

WinSPC schema within the WinSPC database. 
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17. If you selected a language other than English in step 11 of this 

section, an Add Language screen appears once the WinSPC 

schema is created.  In this case: 

a. Insert the language disk for the selected language into your 

floppy drive and click the OK button.   

b. In the message asking if you want to proceed with the addition 

of the detected language, click OK. 

c. If a message indicating the detected language has already been 

installed appears, click OK. 

d. Allow the Adding New Language progress bar to complete. 

e. When the You may now select the desired language in the 

System Settings, Station Setup, or User Setup message 

appears, click OK.   

f. If the Add Language screen reappears, click Cancel. 

g. Remove the language disk from the floppy drive. 

NOTE: Language disks are included in your WinSPC materials.  

If you didn’t order a language disk and, consequently, did 

not receive one, click the Cancel button and complete the 

Initial System Setup Wizard without adding the language.  

Later, you can order the language disk and, once the disk 

arrives, add the language using the Add Language option 

on the Administrator window’s Tools menu in WinSPC.  

Until the language is added, you’ll be restricted to 

running WinSPC in English.  (The remainder of the 

Initial System Setup Wizard continues to run in the 

selected language whether or not a language is added 

from a language disk.) 
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THIS COMPLETES PHASE 2 OF 4.   

GO TO CHAPTER 6: FIRST CLIENT 

CONFIGURATION (FINAL STEPS) AND 

COMPLETE PHASE 3. 
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CHAPTER 4: ORACLE9i 

ASSUMPTIONS 

The instructions in this chapter are based on the following 

assumptions: 

� Oracle9i Database software is installed on your database server. 

� An Oracle9i General Purpose global database of the Enterprise 

Edition installation type is created and running on your database 

server and you have been authorized to use part of this global 

database for WinSPC. 

� Oracle9i Client is installed on the first WinSPC client machine and 

that installation is of the Administrator type (as compared to the 

Runtime or Custom types).  (The first WinSPC client machine 

simply refers to the first computer on which you want to install 

WinSPC.  This computer can be any client machine on your 

network.) 

� Oracle 9i Client is also installed on all additional client machines 

which are to run WinSPC and these installations are of the 

Runtime type. 

� The default values presented by Oracle9i Database and Oracle9i 

Client during the installation process were accepted without 

modification.   

� Any firewalls between your database server and the client 

machines to be used for WinSPC are properly configured to permit 

database traffic. 
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� For implementations employing a Microsoft Terminal Services 

environment, Microsoft Terminal Services is properly installed and 

configured on the server designated as your Microsoft Terminal 

Services server. 

NOTE: You may find that users who don’t have administrative 

permissions to the Microsoft Terminal Services server are 

unable to launch WinSPC via a Remote Desktop Protocol 

session.  This is a circumstance specific to Oracle 9i 

Database and Oracle Database 10g.  It can be remedied 

by changing the Permission Capability on the Microsoft 

Terminal Services server from Full Security to Relaxed 

Security.  Alternatively, consult your network 

administrator and/or Oracle DBA for other remedies.   

� The operating system of your database server machine is Windows 

2003 Server. 

� The operating system of the client machines to be used for 

WinSPC is Windows XP Pro. 

NOTE: If a default value was modified during the installation of 

Oracle9i or an operating system is different from that stated 

here, adapt the instructions in this guide as needed to 

accommodate the modified value or differing operating 

system. 

Prior to beginning this procedure, it’s advised that you locate 

the hostname (or machine name) for the Oracle9i Database 

machine and the Oracle9i global database system identifier 

(SID), user name and password created during the installation 

of Oracle9i Database.  Your database administrator should be 

able to provide this information. 

 



Chapter 4: Oracle9i 

  Installation and Configuration Guide 85 

Phase 1 of 4 

  
 

SERVER CONFIGURATION 

Create a Tablespace 

1. On the first WinSPC client machine, select Start > All Programs 

> Oracle – OraHome92 > Enterprise Manager Console.  (See 

the third assumption at the beginning of this chapter for a 

definition of the first WinSPC client machine.) 

2. In the Oracle Enterprise Manager Console Login dialog box, 

accept the Launch standalone default and click OK.  
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3. In the Add Databases To Tree dialog box: 

a. At Hostname, enter the machine name of the Oracle9i 

Database server. 

b. At Port Number, accept the default value of 1521 unless your 

DBA has instructed you to use a different port number. 

c. At SID, enter the system identifier for the Oracle global 

database to be used by WinSPC. 

d. At Net Service Name, overwrite the net service name that is 

automatically created with a name you want to use to uniquely 

identify the WinSPC net service.  (The recommended net 

service name is WINSPC.)   

e. Click OK. 
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NOTE: If the Add Databases To Tree dialog box doesn’t 

automatically appear after step 2, it can be displayed by 

selecting Add Database To Tree from the Navigator 

menu in the Oracle Enterprise Manager Console. 

4. In the left pane of the Oracle Enterprise Manager Console, 

expand Network > Databases and click the plus sign to the left of 

the net service name from step 3d. 
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5. In the Database Connect Information dialog box that is 

displayed:  

a. At Username, enter the username for the global database. 

b. At Password, enter the password associated with this user 

name. 

c. At Connect as, select SYSDBA from the dropdown list. 

d. Click OK. 
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6. In the left pane, beneath the newly added net service name, expand 

Storage, right-click Tablespaces and, from the shortcut menu, 

select Create. 
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7. In the Create Tablespace dialog box, on the General tab: 

a. At Name, create and enter a name for the tablespace to be used 

for WinSPC.  (Notice that, as you enter the name, it is 

automatically populated into the Datafiles section, forming a 

file name for the tablespace.) 

b. At Size, double-click 5. 
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8. In the Create Datafile dialog box, click the Storage tab. 
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9. On the Storage tab: 

a. Check the Automatically extend datafile when full 

(AUTOEXTEND) check box. 

b. Specify 5 M Bytes as the size by which the datafile should be 

incremented.  (Your database administrator can monitor your 

database usage and tune this value as needed.) 

c. At Maximum Size, accept the default Unlimited. 

d. Click OK. 
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10. In the Create Tablespace dialog box, click Create. 

 

11. When the Tablespace created successfully message appears, click 

OK. 
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Create a Server Login 

1. Still beneath the newly created net service name, expand Security, 

right-click Users and, from the shortcut menu, click Create. 

 

2. In the Create User dialog box, on the General tab: 

a. At Name, create and enter a name for the login.  (The 

recommended user name is JOHNDOE.) 

b. At Enter Password, create and enter a sufficiently strong 

password for the login. 

c. At Confirm Password, reenter the password. 
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NOTE: The name and password entered here will be used by 

Oracle9i Database to authentic WinSPC client machines 

and allow authenticated machines access to the WinSPC 

tablespace.  This name and password combination is not 

directly used by WinSPC users.  WinSPC users will, 

later, be assigned individual user IDs and passwords.  

They will use these individual user IDs and passwords to 

log into the WinSPC application on WinSPC client 

machines. 

d. In the Tablespaces section, at Default, select the tablespace 

name created in step 7a of this chapter’s Create a Tablespace 

section.  

e. At Temporary, select TEMP.  
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f. Leave Status as Unlocked. 
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3. Without clicking Create, click the Role tab and, in the Available 

list, double-click RESOURCE.  This copies RESOURCE to the 

Granted list. 
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4. Click the System tab and, in the Available list, double-click 

CREATE ANY INDEX.  This copies CREATE ANY INDEX to 

the Granted list. 

 

5. Click Create. 

6. When the User created successfully message appears, click OK. 
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Set the Number of Open Cursors 

1. Calculate the required number of open cursors using this formula: 

open_cursors = number of WinSPC licenses * 50 

2. Still in the Oracle Enterprise Manager Console, in the left pane, 

expand Instance, click Configuration and then, in the right pane, 

click All Initialization Parameters toward the bottom of the 

General tab.  
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3. In the Edit Database: Configuration dialog box, scroll to 

open_cursors, replace the default number of open cursors in the 

Value column with the number you calculated in step 1 and click 

Apply. 

 

4. When the Parameters have been changed message appears, click 

OK.  

 

5. Close the Oracle Enterprise Manager Console by clicking File > 

Exit. 
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Test the Local Net Service Name 

1. Still on the first client machine, click Start > All Programs > 

Oracle-OraHome92 > Configuration and Migration Tools > 

Net Configuration Assistant. 

2. In the Oracle Net Configuration Assistant: Welcome dialog box, 

select Local Net Service Name configuration and click Next. 
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3. Select Test and click Next. 
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4. Select the net service name you specified in step 3d of this 

chapter’s Create a Tablespace section, if it isn’t already selected, 

and click Next.  
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5. In the next dialog box, which indicates the test did not succeed, 

click the Change Login button. 

 

6. In the Change Login dialog box, replace the default username and 

password with the username and password you created in step 2 of 

this chapter’s Create a Server Login section and click OK. 
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7. When the test is indicated as having succeeded, click Next. 
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8. Click Next when the net service name configuration is indicated as 

complete. 
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9. On the Welcome dialog box, click Finish.   

 

THIS COMPLETES PHASE 1 OF 4. 

GO TO THE NEXT PAGE AND COMPLETE PHASE 2. 
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Phase 2 of 4 

  
 

FIRST CLIENT INSTALL AND CONFIGURATION (INITIAL STEPS) 

This section concerns the installation and configuration of WinSPC on 

the first WinSPC client machine.  (See the third assumption at the 

beginning of this chapter for a definition of the first WinSPC client 

machine.) 

If your implementation employs Microsoft Terminal Services, see the 

discussion on page 1 of this guide for direction on whether to make 

your first client the Microsoft Terminal Services server or another 

computer.   

1. Create a folder on a network file server accessible by all client 

machines that will run WinSPC.  This folder’s primary purpose is 

to facilitate the installation and configuration of WinSPC on all 

clients other than the first client.  (The recommended name for this 

folder is WinSPCRemote.) 

2. Share this folder and grant domain administrators a minimum of 

Change share permissions and Modify security permissions to it.  

(For a procedure on granting share or security permissions, see 

Appendix D: Granting Share and Security Permissions.) 

NOTE: If your WinSPC implementation is part of a workgroup 

rather than a domain, grant these Change and Modify 

permissions to the local administrator who will install and 

configure WinSPC on the first WinSPC client machine. 

3. Log into Windows on the first WinSPC client machine as a domain 

administrator who also has local administrator privileges, if you 

are not already logged in as such an administrator. 

NOTE: If the first WinSPC client machine is part of a workgroup 

instead of a domain, log in as a local administrator. 
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4. Insert the WinSPC CD into the first WinSPC client’s CD-ROM 

drive.  If autorun is enabled on the client, the CD will start 

automatically.  If autorun is not enabled: 

a. Click Start > My Computer. 

b. In the My Computer dialog box, double-click your CD-ROM 

drive. 

c. When the list of files appears, double-click Setup.exe. 

5. When the WinSPC Setup screen appears, click Install WinSPC. 

6. Install WinSPC by following the setup prompts.  During this 

installation, after the step when programs files are copied, close the 

folder that automatically opens.  When the Setup Complete screen 

appears, click Finish. 

NOTE: The setup prompts are intended to be self-explanatory.  

Consequently, they are not detailed here.  If you have a 

question about a prompt or want to be directed step-by-

step through the setup wizard, see Appendix A:  

WinSPC Setup Prompts. 

7. Complete Appendix B: Installing NJWin for an Asian 

Language if the first client machine will need to run WinSPC in 

an Asian language or you would like to run the Initial System 

Setup Wizard in an Asian language.  (The Initial System Setup 

Wizard is the tool you will use next in this first client configuration 

process.) 

8. Exit the WinSPC Setup screen by clicking the X in the upper right 

corner. 

9. Remove the WinSPC CD from the CD-ROM drive. 
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10. Run WinSPC.  The default path for doing this is Start > All 

Programs > WinSPC > WinSPC CS.  This launches the Initial 

System Setup Wizard. 

11. On the Language screen, from the Select language list, choose a 

language and click Next. 

 

NOTE: The language selected here becomes the language in 

which the remainder of the Initial System Setup Wizard 

will be run.  It also becomes the system-wide default 

language for WinSPC.  (This default language can be 

changed at any time following the completion of the 

Initial System Setup Wizard.  See the Help in WinSPC 

for more information on default languages once the 

configuration of the first WinSPC client is complete.) 
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12. On the Database Server Type screen, select Oracle9i Database 

and click Next.  (Notice this screen is displayed in the language 

selected during the preceding step.) 
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13. On the Oracle Server Settings screen: 

a. At Path of TNSNAMES.ORA, accept the default location. 

b. In the Database Alias text box, enter the Net Service Name 

you chose in step 3d of this chapter’s Create a Tablespace 

section. 

c. At Oracle Driver, leave the default OCI.DLL selected. 

d. Click Next. 
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14. On the Database Server Log In screen, enter the tablespace login 

User Name and Password created in step 2 of this chapter’s 

Create a Server Login section and click Next. 
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15. On the Database Communications Test screen, click Next. 

 

NOTE: In the event the test fails: 

� If the error message displayed reads Unknown 

network error.  ORA-12154: TNS: could not 

resolve service name., click the Back button three 

times and reenter the database alias, ensuring you 

have the correct name and that it is spelled correctly.  

Once you’ve reentered this information, advance 

through the Initial System Setup Wizard again by 

clicking Next, verifying the information on each 

screen as you do. 
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� If the error message reads Unknown user name or 

password., click the Back button twice and reenter 

the server user name and password, ensuring you 

have the correct user name and password and that 

these are spelled correctly.  Also, since passwords are 

case sensitive, ensure the appropriate capitalization is 

used for the password.  Once you’ve reentered this 

information, advance through the Initial System Setup 

Wizard again by clicking Next, verifying the 

information on each screen as you do. 
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16. On the Database Creation screen, click Next.  This creates the 

WinSPC schema within the WinSPC database. 
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17. If you selected a language other than English in step 11 of this 

section, an Add Language screen appears once the WinSPC 

schema is created.  In this case: 

a. Insert the language disk for the selected language into your 

floppy drive and click the OK button.   

b. In the message asking if you want to proceed with the addition 

of the detected language, click OK. 

c. If a message indicating the detected language has already been 

installed appears, click OK. 

d. Allow the Adding New Language progress bar to complete. 

e. When the You may now select the desired language in the 

System Settings, Station Setup, or User Setup message 

appears, click OK. 

f. If the Add Language screen reappears, click Cancel. 

g. Remove the language disk from the floppy drive. 

NOTE: Language disks are included in your WinSPC materials.  

If you didn’t order a language disk and, consequently, did 

not receive one, click the Cancel button and complete the 

Initial System Setup Wizard without adding the language.  

Later, you can order the language disk and, once it 

arrives, add the language using the Add Language option 

on the Administrator window’s Tools menu in WinSPC.  

Until the language is added, you’ll be restricted to 

running WinSPC in English.  (The remainder of the 

Initial System Setup Wizard continues to run in the 

selected language whether or not a language is added 

from a language disk.) 
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THIS COMPLETES PHASE 2 OF 4.   

GO TO CHAPTER 6: FIRST CLIENT 

CONFIGURATION (FINAL STEPS) AND 

COMPLETE PHASE 3. 
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CHAPTER 5: ORACLE 10g 

ASSUMPTIONS 

The instructions in this chapter are based on the following 

assumptions: 

� Oracle Database 10g software is installed on your database server. 

� An Oracle Database 10g global database of the Enterprise 

Edition installation type is created and running on your database 

server and you have been authorized to use part of this global 

database for WinSPC. 

� Oracle Database 10g Client is installed on the first WinSPC client 

machine and that installation is of the Administrator type (as 

compared to the Runtime or Custom types).  (The first WinSPC 

client machine simply refers to the first computer on which you 

want to install WinSPC.  This computer can be any client machine 

on your network.) 

� Oracle Database 10g is also installed on all additional client 

machines which are to run WinSPC and these installations are of 

the Runtime type. 

� The default values presented by Oracle Database 10g and Oracle 

Database 10g Client during the installation process were accepted 

without modification.   

� Any firewalls between your database server and the client 

machines to be used for WinSPC are properly configured to permit 

database traffic. 
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� For implementations employing a Microsoft Terminal Services 

environment, Microsoft Terminal Services is properly installed and 

configured on the server designated as your Microsoft Terminal 

Services server. 

NOTE: You may find that users who don’t have administrative 

permissions to the Microsoft Terminal Services server are 

unable to launch WinSPC via a Remote Desktop Protocol 

session.  This is a circumstance specific to Oracle 9i 

Database and Oracle Database 10g.  It can be remedied 

by changing the Permission Capability on the Microsoft 

Terminal Services server from Full Security to Relaxed 

Security.  Alternatively, consult your network 

administrator and/or Oracle DBA for other remedies.   

� The operating system of your database server machine is Windows 

2003 Server. 

� The operating system of the client machines to be used for 

WinSPC is Windows XP Pro. 

NOTE: If a default value was modified during the installation of 

Oracle Database 10g or an operating system is different from 

that stated here, adapt the instructions in this guide as needed 

to accommodate the modified value or differing operating 

system. 

Prior to beginning this procedure, it’s advised that you locate 

the hostname (or machine name) for the Oracle Database 10g 

machine and the Oracle Database 10g global database system 

identifier (SID), user name and password created during the 

installation of Oracle Database 10g.  Your database 

administrator should be able to provide this information. 
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Phase 1 of 4 

  
 

SERVER CONFIGURATION 

Create a Tablespace 

1. On the first WinSPC client machine, select Start > All Programs 

> Oracle – OraClient10g_home1 > Enterprise Manager 

Console.  (See the third assumption at the beginning of this chapter 

for a definition of the first WinSPC client.) 

NOTE: If the Enterprise Manager Console is not listed, it is 

probably because the Administrator installation type 

was not selected when Oracle Database 10g Client was 

installed.  In this case, reinstall Oracle Database 10g 

Client, selecting Administrator in the Select 

Installation Type dialog box and then return to this step. 
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2. In the Add Databases To Tree dialog box: 

a. At Hostname, enter the machine name of the Oracle Database 

10g server. 

b. At Port Number, accept the default value of 1521 unless your 

DBA has instructed you to use a different port number. 

c. At SID, enter the system identifier for the Oracle global 

database to be used by WinSPC. 

d. At Net Service Name, overwrite the net service name that is 

automatically created with a name you want to use to uniquely 

identify the WinSPC net service.  (The recommended net 

service name is WINSPC.)   

e. Click OK. 
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NOTE: If the Add Databases To Tree dialog box doesn’t 

automatically appear after step 1, it can be displayed by 

selecting Add Database To Tree from the Navigator 

menu in the Oracle Enterprise Manager Console. 

3.   In the left pane of the Oracle Enterprise Manager Console, 

expand Network > Databases and click the plus sign to the left of 

the net service name from step 2d. 
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4.   In the Database Connect Information dialog box that is 

displayed:  

a. At Username, enter the username for the global database. 

b. At Password, enter the password associated with this user 

name. 

c. At Connect as, select SYSDBA from the dropdown list. 

d. Click OK. 
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5.   In the left pane, beneath the newly added net service name, expand 

Storage, right-click Tablespaces and, from the shortcut menu, 

select Create. 

NOTE: If you do not see Create on the shortcut menu, press the 

ESC button to exit the menu and right-click Tablespaces 

again. 
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6.   In the Create Tablespace dialog box, on the General tab: 

a. At Name, create and enter a name for the tablespace to be used 

for WinSPC.  (Notice that, as you enter the name, it is 

automatically populated into the Datafiles section, forming a 

file name for the tablespace.) 

b. At Size, double-click 5. 
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7.   In the Create Datafile dialog box that is displayed, click the 

Storage tab. 
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8.   On the Storage tab: 

a. Check the Automatically extend datafile when full 

(AUTOEXTEND) check box. 

b. Specify 5 M Bytes as the size by which the datafile should be 

incremented.  (Your database administrator can monitor your 

database usage and tune this value as needed.) 

c. At Maximum Size, accept the default Unlimited. 

d. Click OK. 
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9.   In the Create Tablespace dialog box, click Create. 

 

10.  When the Tablespace created successfully message appears, 

click OK. 
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Create a Server Login 

1. Still beneath the newly created net service name, expand Security, 

right-click Users and, from the shortcut menu, click Create. 

 

2. In the Create User dialog box, on the General tab: 

a. At Name, create and enter a name for the login.  (The 

recommended user name is JOHNDOE.) 

b. At Enter Password, create and enter a sufficiently strong 

password for the login. 

c. At Confirm Password, reenter the password. 

NOTE: The name and password entered here will be used by 

Oracle Database 10g to authentic WinSPC client 

machines and allow authenticated machines access to the 

WinSPC tablespace.  This name and password 

combination is not directly used by WinSPC users.  
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WinSPC users will, later, be assigned individual user IDs 

and passwords.  They will use these individual user IDs 

and passwords to log into the WinSPC application on 

WinSPC client machines. 

d. In the Tablespaces section, at Default, select the tablespace 

name created in step 6a of this chapter’s Create a Tablespace 

section.  

e. At Temporary, select TEMP.  
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f. Leave Status as Unlocked. 
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3. Without clicking Create, click the Role tab and, in the Available 

list, double-click RESOURCE.  This copies RESOURCE to the 

Granted list. 
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4. Click the System tab and, in the Available list, double-click 

CREATE ANY INDEX.  This copies CREATE ANY INDEX to 

the Granted list. 

 

5. Click Create. 

6. When the User created successfully message appears, click OK. 
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Set the Number of Open Cursors 

1. Calculate the required number of open cursors using this formula: 

open_cursors = number of WinSPC licenses * 50 

2. Still in the Oracle Enterprise Manager Console, in the left pane, 

expand Instance, click Configuration and then, in the right pane, 

click All Initialization Parameters toward the bottom of the 

General tab.  
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3. In the Edit Database: Configuration dialog box, scroll to 

open_cursors, replace the default number of open cursors in the 

Value column with the number you calculated in step 1 and click 

Apply. 

 

4. When the Parameters have been changed message appears, click 

OK.  

 

5. Close the Oracle Enterprise Manager Console by clicking File > 

Exit. 
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Test the Local Net Service Name 

1. Still on the first client machine, click Start > All Programs > 

Oracle – OraClient10g_home1 > Configuration and Migration 

Tools > Net Configuration Assistant. 

2. In the Oracle Net Configuration Assistant:Welcome dialog box, 

select Local Net Service Name configuration and click Next. 
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3. Select Test and click Next. 

 



Chapter 5: Oracle 10g 

  Installation and Configuration Guide 139 

4. Select the net service name you specified in step 2d of this 

chapter’s Create a Tablespace section, if it isn’t already selected, 

and click Next.  
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5. In the next dialog box, which indicates the test did not succeed, 

click the Change Login button. 

 

6. In the Change Login dialog box, replace the default username and 

password with the username and password you created in step 2 of 

this chapter’s Create a Server Login section and click OK. 
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7. When the test is indicated as having succeeded, click Next. 
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8. Click Next when the net service name configuration is indicated as 

complete. 
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9. On the Welcome dialog box, click Finish. 

 

THIS COMPLETES PHASE 1 OF 4. 

GO TO THE NEXT PAGE AND COMPLETE PHASE 2. 
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 FIRST CLIENT INSTALL AND CONFIGURATION (INITIAL STEPS) 

This section concerns the installation and configuration of WinSPC on 

the first WinSPC client machine.  (See the third assumption at the 

beginning of this chapter for a definition of the first WinSPC client 

machine.) 

If your implementation employs Microsoft Terminal Services, see the 

discussion on page 1 of this guide for direction on whether to make 

your first client the Microsoft Terminal Services server or another 

computer.   

1. Create a folder on a network file server accessible by all client 

machines that will run WinSPC.  This folder’s primary purpose is 

to facilitate the installation and configuration of WinSPC on all 

clients other than the first client.  (The recommended name for this 

folder is WinSPCRemote.) 

2. Share this folder and grant domain administrators a minimum of 

Change share permissions and Modify security permissions to it.  

(For a procedure on granting share or security permissions, see 

Appendix D: Granting Share and Security Permissions.) 

NOTE: If your WinSPC implementation is part of a workgroup 

rather than a domain, grant these Change and Modify 

permissions to the local administrator who will install and 

configure WinSPC on the first WinSPC client machine. 

3. Log into Windows on the first WinSPC client machine as a domain 

administrator who also has local administrator privileges, if you 

are not already logged in as such an administrator. 

NOTE: If the first WinSPC client machine is part of a workgroup 

instead of a domain, log in as a local administrator. 
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4. Insert the WinSPC CD into the first WinSPC client’s CD-ROM 

drive.  If autorun is enabled on the client, the CD will start 

automatically.  If autorun is not enabled: 

a. Click Start > My Computer. 

b. In the My Computer dialog box, double-click your CD-ROM 

drive. 

c. When the list of files appears, double-click Setup.exe. 

5. When the WinSPC Setup screen appears, click Install WinSPC. 

6. Install WinSPC by following the setup prompts.  During this 

installation, after the step when programs files are copied, close the 

folder that automatically opens.  When the Setup Complete screen 

appears, click Finish. 

NOTE: The setup prompts are intended to be self-explanatory.  

Consequently, they are not detailed here.  If you have a 

question about a prompt or want to be directed step-by-

step through the setup wizard, see Appendix A:  

WinSPC Setup Prompts toward the end of this guide. 

7. Complete Appendix B: Installing NJWin for an Asian 

Language if the first client machine will need to run WinSPC in 

an Asian language or you would like to run the Initial System 

Setup Wizard in an Asian language.  (The Initial System Setup 

Wizard is the tool you will use next in this first client configuration 

process.) 

8. Exit the WinSPC Setup screen by clicking the X in the upper right 

corner. 

9. Remove the WinSPC CD from the CD-ROM drive. 
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10. Run WinSPC.  The default path for doing this is Start > All 

Programs > WinSPC > WinSPC CS.  This launches the Initial 

System Setup Wizard. 

11. On the Language screen, from the Select language list, choose a 

language and click Next.  

 

NOTE: The language selected here becomes the language in 

which the remainder of the Initial System Setup Wizard 

will be run.  It also becomes the system-wide default 

language for WinSPC.  (This default language can be 

changed at any time following the completion of the 

Initial System Setup Wizard.  See the Help in WinSPC 

for more information on default languages once the 

configuration of the first WinSPC client is complete.) 
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12. On the Database Server Type screen, select Oracle Database 

10g and click Next.  (Notice this screen is displayed in the 

language selected during the preceding step.) 
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13. On the Oracle Server Settings screen: 

a. At Path of TNSNAMES.ORA, accept the default location. 

b. In the Database Alias text box, enter the Net Service Name 

you chose in step 2d of this chapter’s Create a Tablespace 

section. 

c. At Oracle Driver, leave the default OCI.DLL selected. 

d. Click Next. 
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14. On the Database Server Log In screen, enter the tablespace login 

User Name and Password created in step 2 of this chapter’s 

Create a Server Login section and click Next. 
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15. On the Database Communications Test screen, click Next. 

 

NOTE: In the event the test fails: 

� If the error message displayed reads Unknown 

network error.  ORA-12154: TNS: could not 

resolve the connect identifier specified., click the 

Back button three times and reenter the database 

alias, ensuring you have the correct name and that it 

is spelled correctly.  Once you’ve reentered this 

information, advance through the Initial System Setup 

Wizard again by clicking Next, verifying the 

information on each screen as you do. 
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� If the error message reads Unknown user name or 

password., click the Back button twice and reenter 

the server user name and password, ensuring you 

have the correct user name and password and that 

these are spelled correctly.  Also, since passwords are 

case sensitive, ensure the appropriate capitalization is 

used for the password.  Once you’ve reentered this 

information, advance through the Initial System Setup 

Wizard again by clicking Next, verifying the 

information on each screen as you do. 

16. On the Database Creation screen, click Next.  This creates the 

WinSPC schema within the WinSPC database. 
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17. If you selected a language other than English in step 11 of this 

section, an Add Language screen appears once the WinSPC 

schema is created.  In this case: 

a. Insert the language disk for the selected language into your 

floppy drive and click the OK button.   

b. In the message asking if you want to proceed with the addition 

of the detected language, click OK. 

c. If a message indicating the detected language has already been 

installed appears, click OK. 

d. Allow the Adding New Language progress bar to complete. 

e. When the You may now select the desired language in the 

System Settings, Station Setup, or User Setup message 

appears, click OK. 

f. If the Add Language screen reappears, click Cancel. 

g. Remove the language disk from the floppy drive. 

NOTE: Language disks are included in your WinSPC materials.  

If you didn’t order a language disk and, consequently, did 

not receive one, click the Cancel button and complete the 

Initial System Setup Wizard without adding the language.  

Later, you can order the language disk and, once it 

arrives, add the language using the Add Language option 

on the Administrator window’s Tools menu in WinSPC.  

Until the language is added, you’ll be restricted to 

running WinSPC in English.  (The remainder of the 

Initial System Setup Wizard continues to run in the 

selected language whether or not a language is added 

from a language disk.) 
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THIS COMPLETES PHASE 2 OF 4.   

GO TO CHAPTER 6: FIRST CLIENT 

CONFIGURATION (FINAL STEPS) AND 

COMPLETE PHASE 3. 
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Phase 3 of 4 

  
 

CHAPTER 6: FIRST CLIENT CONFIGURATION 

(FINAL STEPS) 

This chapter consists of the final steps to configure the first WinSPC 

client.  With a few exceptions, these steps are common to all database 

servers.  They begin midway through the Initial System Setup Wizard, 

just after the creation of the WinSPC schema.   

1. On the Remote Configuration Image Directory screen: 

a. Click the Browse button. 

b. In the Directory Selection dialog box that opens, navigate to 

and select the shared folder created for WinSPC, then click 

OK.  This closes the Directory Selection dialog box and 

populates the shared folder path in the Directory text box of 

the Remote Configuration Image Directory screen. 

NOTE: The shared folder referred to here is the one created in 

step 1 of the First Client Install and Configuration 

(Initial Steps) section that you completed prior to 

coming the this chapter. 

c. Click Next. 
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2. On the Remote Configuration Image Copy screen, click Next.  

This copies the files needed for the installation and configuration 

of additional WinSPC clients to the shared folder. 
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3. On the Custom Web Reporter Setup screen, if you want to install 

Custom Web Reporter on the first client or you think you may, at 

some point, want to install it on an additional client, click Next.  

Otherwise, click Skip and advance to step 6 of this procedure. 

NOTE: An installation of Custom Web Reporter comes with a 

free 60-day license.  For information on purchasing 

permanent licenses, contact DataNet Quality Systems.   
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4. On the Statit(r) Licensing Information screen, read the license 

agreement and, if you agree, click I Agree. 
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5. On this Custom Web Reporter Setup screen, click Next.  This 

installs Custom Web Reporter on the first client and copies the 

installation files for Custom Web Reporter to the shared folder. 
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6. On the System Administrator Password screen, create and enter 

a sufficiently strong, case-sensitive password for the Admin user in 

both the Password and Confirm Password text boxes and click 

Next. 

 

NOTE: This Admin user is the only user with complete WinSPC 

permissions. 
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7. On the Finished screen that appears, click Finish.  This causes the 

Initial System Setup Wizard to close… 
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…and the WinSPC C/S Access Center to open. 

 

8. If, earlier in this chapter, you skipped the installation of Custom 

Web Reporter, click the Exit button and go to step 9.  If you 

installed Custom Web Reporter, run it once while logged into 

Windows as an administrator.  To do this: 

a. At User Name, enter Admin. 

b. At Password, enter the password for the Admin user created is 

step 6 above. 

c. Click the Log In button. 

d. In the Administrator window that appears, click the Query 

Tool tool bar button. 
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e. In the Query Selector dialog box that is displayed, click the 

New Query button. 

 

This creates a new query icon and a text box for the name of 

the new query. 

 

f. Click the Edit button. 

g. In the Query Builder dialog box: 

i. At Source Database, leave the Main option selected. 

ii. Under WinSPC C/S in the middle left pane of the dialog 

box, single-click Parts/Processes. 

iii. In the middle right pane, double-click Penny. 
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iv. Still in the middle right pane, double-click Diameter.  This 

copies Diameter to the bottom pane. 

v. Click OK. 

h. Back in the Query Selector, click the Open button.  This 

causes a chart to be displayed in the Query Tool. 

i. In the Query Tool, click the Custom Web Reporter tool bar 

button. 

 

j. In the Custom Web Reporter Options dialog box that 

appears, check the Run Report on Each Characteristic check 

box and click OK. 

k. If a message that reads The Custom Web Reporter was not 

found, so it will be installed now is displayed, click OK.  This 

causes an Installing progress bar to briefly appear and then 

Custom Web Reporter to open.  (Note: This message is only 

displayed when this procedure is completed from an additional 

client as directed by step 5 of Chapter 7: Additional Client 

Installs and Configuration.) 

l. From the Custom Web Reporter’s menu bar, click File > Exit. 

m. In the Save Workspace dialog box that is displayed, click No. 

n. In the Save Procedure Log dialog box, click No.  This causes 

Custom Web Reporter to close. 

o. In the Query Tool, click the Select query tool bar button. 

p. In the Query Selector, single-click New Query under Query 

Books and click the Delete button. 

q. Click the Confirm message’s Yes button. 
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r. Click the Close button in the Query Selector. 

s. Close the Query Tool by clicking Exit from the Query menu. 

t. Close the Administrator window by clicking Exit from the 

File menu. 

u. In the Access Center, click the Exit button. 

9. If your first client is your Microsoft Terminal Services server: 

a. Navigate to and double-click winspc.ini.  The default 

installation location for this file is C:\Program Files > DQS > 

WinSPC > winspc.ini. 

b. Insert a blank line directly below this file’s [System] heading. 

c. On that line, enter TerminalServices=1.  This informs 

WinSPC at startup that the environment is a Terminal Services 

environment. 
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d. Indicate whether WinSPC is to name stations based on the 

connecting station or the connecting user. This is done by 

specifying either station mode or user mode as the mode in 

which WinSPC is to run. In station mode, WinSPC uses the ID 

of the station RDPing into the Microsoft Terminal Services 

server as the station name. In user mode, WinSPC uses the ID 

of the user (i.e. the login ID with which a user logs into 

Windows on the Microsoft Terminal Services server via a RDP 

session) as the station name. For example, say Bob logs into a 

station named Finishing and then, via RDP, logs into the 

Microsoft Terminal Services server as Sally. With station mode 

enabled, WinSPC will use Finishing as the station name. With 

user mode enabled, WinSPC will use Sally as the station name. 

Station mode is the default mode in which WinSPC runs and, 

consequently, nothing needs to be done to enable it. To enable 

user mode, directly beneath the TerminalServices=1 line 

entered in the preceding step, enter a UserMode=1 line. 

NOTE: To disable user mode in the future and have WinSPC 

run in station mode, delete the UserMode=1 line or 

change this line to UserMode=0. 

e. If you enabled user mode in the preceding step, configure 

Microsoft Terminal Services to disallow simultaneous sessions 

from a user. To do this: 

i. On the Microsoft Terminal Services server, launch 

Terminal Services Configuration, the default path for 

which in Windows 2003 Server is Start > All Programs > 

Administrative Tools > Terminal Services 

Configuration. 

ii. In the left pane of the Terminal Services Configuration 

window, single-click the Server Settings folder. 
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iii. In the right pane, right-click Restrict each user to one 

session and, from the shortcut menu that appears, click 

Yes. 

iv. Close Terminal Services Configuration. 

f. Save and close winspc.ini. 

NOTE: The remaining steps of this procedure concern granting 

permissions for users of WinSPC on the first client.  The 

permissions granted by these steps are the minimum 

permissions required to run WinSPC.  These steps assume 

your WinSPC implementation employs network domains.  If 

your implementation employs workgroups, instead of 

completing these steps, complete Appendix C: WinSPC 

Security for Workgroups.   

10. If you are logged into Windows on the first WinSPC client 

machine as anything other than a domain administrator, log out 

and log back in as a domain administrator.  (This is necessary 

because you will be creating a user group for WinSPC users on the 

domain controller.) 

11. Navigate to the shared folder created for WinSPC and, within this 

folder’s Utility folder, double-click WinSPCSecurity. 
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12. In the WinSPC Security utility that launches, toward the bottom 

of the Groups tab, at Group Name, create and enter a name for a 

user group that will consist of WinSPC users.  (The recommended 

name for this user group is WinSPC Users.) 
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13. Click the Create New Group button.   

 

This causes the user group to be added to the list of groups above 

and creates the user group on the domain controller. 
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14. Check the check box for the new user group. 
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15. Click the Apply Updates button. 

 

This causes an Applying Permissions progress bar to appear. 

 

16. When the Permissions Applied message appears, click its OK 

button and close the Security Utility by clicking the X in the upper 

right corner. 

NOTE: The next three steps concern granting share and security 

permissions.  For a procedure on granting permissions, see 

Appendix D: Granting Share and Security Permissions. 

17. If your database server is Oracle9i, grant the newly created user 

group for WinSPC users Modify security permissions to the 

required Oracle9i Client folders and files on the first client 

machine.  The required folders and files include—assuming default 

names and locations were accepted during the installation of 

Oracle9i Client—the C:\Oracle folder and all of this folder’s child 

folders and files. 

NOTE: If default names and locations were modified during the 

installation of Oracle9i Client, you can determine which 

are the required folders and files by searching the client 

machine for the oci.dll file.  This file’s most senior 

Oracle-specific parent folder is the equivalent of the 

default C:\Oracle folder. 
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18. Grant the user group for WinSPC users Change share permissions 

and Modify security permissions to the shared folder and the 

Utility folder within this shared folder. 

19. If your database server is InterBase 6 Server, grant the user group 

for WinSPC users Modify security permissions to the WinSPC 

database file created in step 2 of the Create a Database section of 

Chapter 1: InterBase 6.  Additionally for InterBase 6 Server 

implementations, if during the completion of the Initial System 

Setup Wizard, the NetBEUI protocol was selected rather than the 

TCP/IP protocol, grant the user group for WinSPC users Modify 

security permissions to the isc4.gdb file on your InterBase 6 

Server machine.  The default location for this file is C:\Program 

Files\Borland\InterBase. 

20. On your domain controller, add all users who will be running 

WinSPC and all local administrators who will install and configure 

WinSPC to the newly created user group.  (For a procedure on 

adding users to a user group, see Appendix E: Adding Users to a 

User Group.)  
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THIS COMPLETES PHASE 3 OF 4. 

GO TO CHAPTER 7: ADDITIONAL CLIENT 

INSTALLS AND CONFIGURATIONS AND 

COMPLETE PHASE 4. 

IF YOU DON’T NEED TO INSTALL AND 

CONFIGURE ADDITIONAL CLIENTS, THIS 

CONCLUDES THE ENTIRETY OF THE SETUP 

REQUIRED TO BEGIN USING WINSPC.  FOR 

INSTRUCTIONS ON LAUNCHING AND LOGGING 

INTO WINSPC, SEE APPENDIX F: LAUNCHING 

AND LOGGING INTO WINSPC. 
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Phase 4 of 4 

 
 

CHAPTER 7: ADDITIONAL CLIENT INSTALLS AND 

CONFIGURATIONS 

If your WinSPC implementation utilizes the conventional client/server 

architecture exclusively, meaning it does not employ Microsoft 

Terminal Services at all, complete the procedure in this chapter on 

each additional client station.   

If your implementation utilizes Microsoft Terminal Services 

exclusively, meaning all client stations other than the Microsoft 

Terminal Services server connect to the WinSPC database through the 

Microsoft Terminal Services server, it is not necessary to complete the 

procedure in this chapter. 

If your implementation employs a mix of the conventional 

client/server architecture and a Microsoft Terminal Services 

architecture, complete this chapter for any client station that will be 

connecting to the WinSPC database directly rather than through the 

Microsoft Terminal Services server.  This includes completing the 

procedure on the Microsoft Terminal Services server itself if WinSPC 

was not installed on this server as part of the first client configuration. 

1. Log into Windows on the additional client machine as a local 

administrator. 

2. Using Windows Explorer, navigate to the shared folder created for 

WinSPC and double-click WinSPC.exe. 

 

3. Install WinSPC by following the setup prompts.  During this 

installation, after the step when programs files are copied, close the 
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folder that automatically opens.  When the Setup Complete screen 

appears, click Finish. 

4. Launch and exit WinSPC once while logged into Windows as a 

local administrator.  To do this: 

a. Click WinSPC C/S.  The default path for this is Start > All 

Programs > WinSPC.   

b. In the WinSPC C/S Access Center that appears, click the Exit 

button. 
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5. If you don’t want to install Custom Web Reporter on the additional 

client, go to step 6.  If you want to install Custom Web Reporter 

and you know it has been run on the first client at least once:  

a. Navigate to the shared folder for WinSPC. 

b. In the shared folder’s STATIT subfolder, double-click 

CustomQC541OEM.exe.  This causes an Installing progress 

bar to briefly appear and then disappear, indicating the Custom 

Web Reporter installation is complete. 

NOTE: If you know or suspect Custom Web Reporter was not 

run at least once on the first client, complete step 8 of 

Chapter 6: First Client Configuration (Final Steps) on 

this additional client. 

6. If the additional client is your Microsoft Terminal Services server: 

a. Navigate to and double-click winspc.ini.  The default 

installation location for this file is C:\Program Files > DQS > 

WinSPC > winspc.ini. 

b. Insert a blank line directly below this file’s [System] heading.  
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c. On that line, enter TerminalServices=1.  This informs 

WinSPC at startup that the environment is a Terminal Services 

environment. 

 

d. Indicate whether WinSPC is to name stations based on the 

connecting station or the connecting user. This is done by 

specifying either station mode or user mode as the mode in 

which WinSPC is to run. In station mode, WinSPC uses the ID 

of the station RDPing into the Microsoft Terminal Services 

server as the station name. In user mode, WinSPC uses the ID 

of the user (i.e. the login ID with which a user logs into 

Windows on the Microsoft Terminal Services server via a RDP 

session) as the station name. For example, say Bob logs into a 

station named Finishing and then, via RDP, logs into the 

Microsoft Terminal Services server as Sally. With station mode 

enabled, WinSPC will use Finishing as the station name. With 

user mode enabled, WinSPC will use Sally as the station name. 

Station mode is the default mode in which WinSPC runs and, 
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consequently, nothing needs to be done to enable it. To enable 

user mode, directly beneath the TerminalServices=1 line 

entered in the preceding step, enter a UserMode=1 line. 

NOTE: To disable user mode in the future and have WinSPC 

run in station mode, delete the UserMode=1 line or 

change this line to UserMode=0. 

e. If you enabled user mode in the preceding step, configure 

Microsoft Terminal Services to disallow simultaneous sessions 

from a user. To do this: 

i. On the Microsoft Terminal Services server, launch 

Terminal Services Configuration, the default path for 

which in Windows 2003 Server is Start > All Programs > 

Administrative Tools > Terminal Services 

Configuration. 

ii. In the left pane of the Terminal Services Configuration 

window, single-click the Server Settings folder. 

iii. In the right pane, right-click Restrict each user to one 

session and, from the shortcut menu that appears, click 

Yes. 

iv. Close Terminal Services Configuration. 

f. Save and close winspc.ini. 

7. Complete Appendix B: Installing NJWin for an Asian 

Language if the additional client machine will need to run 

WinSPC in an Asian language. 

NOTE: The remaining steps of this procedure concern granting 

permissions for WinSPC users on the additional client 

machine.  The permissions granted are the minimum 

permissions required to run WinSPC.  These steps assume 
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your WinSPC implementation employs network domains.  If 

your implementation employs workgroups, instead of 

completing these steps, complete Appendix C: WinSPC 

Security for Workgroups.   

(These steps and Appendix C can be disregarded if every 

user of the WinSPC client has local administrator privileges 

on the client machine.  In such a case, close the WinSPC 

shared folder and see Appendix F: Launching and Logging 

Into WinSPC to begin using WinSPC.) 

8. Within the WinSPC shared folder, double-click Utility > 

WinSPCSecurity. 

 

9. In the message indicating the application (i.e. security utility) may 

not run properly if you are not logged into Windows as an 

administrator, click Yes.  (The administrator referred to in this 

message is a domain administrator.  Being logged in as a local 

administrator, however, is sufficient for the remainder of this 

procedure.) 

 

10. In the WinSPC Security utility, on the Groups tab, check the 

check box that corresponds to the name of the user group created 

for WinSPC users.  This name was created in step 12 of Chapter 

6: First Client Configuration (Final Steps). 
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11. Click the Apply Updates button. 
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This causes an Applying Permissions progress bar to appear. 

 

12. When the Permissions Applied message is displayed, click its OK 

button. 

13. Close the Security Utility by clicking the X in its upper right 

corner. 

14. Close the Utility folder. 

15. If the additional client station will be used by any users who were 

not added to the user group for WinSPC users created during the 

first client configuration process, go to the domain controller and 

add them.  (For a procedure on adding users to a user group, see 

Appendix E: Adding Users to a User Group.) 

16. If your database server is Oracle9i, grant the newly created user 

group for WinSPC users Modify security permissions to the 

required Oracle9i Client folders and files on the first client 

machine.  The required folders and files include—assuming default 

names and locations were accepted during the installation of 

Oracle9i Client—the C:\Oracle folder and all of this folder’s child 

folders and files.  (For a procedure on granting security 

permissions, see Appendix D: Granting Share and Security 

Permissions.) 

NOTE: If default names and locations were modified during the 

installation of Oracle9i Client, you can determine which 

are the required folders and files by searching the client 

machine for the oci.dll file.  This file’s most senior 
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Oracle-specific parent folder is the equivalent of the 

default C:\Oracle folder. 

THIS COMPLETES PHASE 4 OF 4. 

NO FURTHER SETUP IS REQUIRED TO BEGIN 

USING WINSPC.  FOR INSTRUCTIONS ON 

LAUNCHING AND LOGGING INTO WINSPC, SEE 

APPENDIX F: LAUNCHING AND LOGGING INTO 

WINSPC. 
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APPENDIX A: WINSPC SETUP PROMPTS 

This appendix details the prompts presented during the installation of 

WinSPC on the first client.  It begins with the first screen displayed 

after Install WinSPC on the WinSPC CD’s WinSPC Setup screen is 

clicked. 

1. On the Welcome screen, click Next. 
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2. Read the software license agreement and, if you accept its terms, 

click Yes to continue.  
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3. On the Readme Information screen, read the information and 

click Next. 
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4. On the User Information screen, enter your Name and Company 

and click Next. 
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5. On the Choose Destination Location screen, accept the default 

destination location or click Browse and select a different location 

and click Next.  Destination location refers to the folder into which 

WinSPC will be installed. 
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6. On the Select Program Folder screen, accept WinSPC as the 

folder within your All Programs menu in which you want the 

WinSPC program to be listed and click Next or, if preferred, 

specify a different folder and click Next. 
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7. Click Next.  The copying of files begins. 
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8. Close the folder that automatically opens. 
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9. On the Setup Complete screen, click Finish. 

 

THIS COMPLETES APPENDIX A. 

RETURN TO AND COMPLETE THE FIRST CLIENT 

INSTALL AND CONFIGURATION (INITIAL 

STEPS) SECTION OF THE CHAPTER YOU WERE ON 

BEFORE COMING TO THIS APPENDIX. 
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APPENDIX B: INSTALLING NJWIN FOR AN 

ASIAN LANGUAGE 

Complete this appendix if you want to run WinSPC or the Initial 

System Setup Wizard in an Asian language on a client machine that is 

running a Romance-language version of Microsoft Windows. 

As you may know, Microsoft Windows is available in several sets of 

languages.  One of these sets is the Romance set, a set which includes 

the English language.  When some non-Romance language translations 

of WinSPC, Asian language translations particularly, are run on a 

Romance-language version of Windows, the characters of the WinSPC 

translation are improperly displayed.  Installing and running NJWin 

remedies this for an Asian language.  (The East Asian language set of 

Microsoft Windows may not require NJWin.) 

For your convenience, a trial version of NJWin is included on the 

WinSPC CD.  If you install and like this trial version, you can 

purchase a license at www.njstar.com. 

1. On the WinSPC Setup screen of the WinSPC CD, click Browse 

Utilities and, from the NJWIN folder, copy the njwin183.exe file 

to the WinSPC shared folder. 

NOTE: This step, which eliminates the need to bring the WinSPC 

CD to each client machine on which NJWin is to be 

installed, only needs to be done once. 
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2. From a client machine on which you want to install NJWin, 

navigate to the shared folder and double-click njwin183.exe. 

3. When the Welcome screen of the NJWin setup wizard appears, 

click Next. 
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4. Read the License Agreement and, if you agree, click Next. 
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5. Specify the folder to which you want the NJWin application files 

copied and click Next. 
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6. When the Ready screen appears, click Next.  This installs NJWin. 
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7. On the Setup was successful screen, click Close. 
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8. On the NJWIN – NJStar CJK Viewer screen that is displayed, 

select the Asian language in which you intend to run WinSPC (or 

the Initial System Setup Wizard) and click OK.  This closes the 

viewer and launches NJWin.  (See the First Client Install and 

Configuration (Initial Steps) section of the chapter specific to 

your database server for information on the Initial System Setup 

Wizard.) 
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9. Close the NJWin – NJStar CJK Viewer folder. 

10. Close the WinSPC shared folder. 

NOTE: NJWin must be running when WinSPC is running for 

WinSPC to properly display Asian language characters.  If 

the operating system of the client machine on which NJWin 

is installed is Windows XP Pro and the default storage 

location was accepted during the installation procedure, 

NJWin can be launched by clicking Start > All Programs > 

NJWIN – NJStar CJK Viewer > NJWIN – NJStar CJK 

Viewer.  Alternatively, WinSPC can be set up to launch 

NJWin automatically.  This is accomplished through the Use 

NJWin check box, a check box found on the setup dialog 

boxes for system settings, station groups, stations, user 

groups and users.  See WinSPC’s Help for more information 

on this check box.  (If you’re ever in doubt as to whether or 

not NJWin is running, press <Ctrl+Alt+Del> and check the 

Applications tab of the Task Manager.) 

 THIS COMPLETES APPENDIX B.  

RETURN TO AND COMPLETE THE PROCEDURE 

YOU WERE WORKING ON PRIOR TO COMING TO 

THIS APPENDIX. 
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APPENDIX C: WINSPC SECURITY FOR 

WORKGROUPS 

This appendix details the procedure for granting permissions to 

WinSPC users on a client machine that is part of a workgroup as 

opposed to a domain.  The permissions granted are the minimum 

permissions required to run WinSPC.  It is to be completed after step 9 

of Chapter 6: First Client Configuration (Final Steps) or after step 

7 of Chapter 7: Additional Client Installs and Configurations. 

1. Navigate to the WinSPC shared folder created during the 

installation and configuration of the first WinSPC client. 

2. Double-click the Utility folder. 

3. Within the Utility folder, double-click the WinSPCSecurity icon. 

 



Appendix C: WinSPC Security for Workgroups 

204 Installation and Configuration Guide 

4. In the WinSPC Security utility that appears, on the Users tab, 

check the check box for each user you want to be able to run 

WinSPC on the client machine. 
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5. Click the Apply Updates button.  This causes a progress bar to 

appear. 

 

6. Once permissions are applied to the first user, a Permissions 

Applied message is displayed.  Click this message’s OK button.  

This causes the Applying Permissions progress bar to appear for 

the next user. 

7. Continue clicking the Applying Permissions message’s OK 

button each time it is displayed. 

8. Once permissions are applied to all selected users, exit the 

WinSPC Security utility by clicking the X in the upper right 

corner.  

NOTE: Later, if you wish to remove previously applied 

permissions, simply uncheck the appropriate check box 

and click the Apply Updates button. 

9. Close the Utility folder. 
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 THIS COMPLETES APPENDIX C.  

IF YOU NEED TO INSTALL AND CONFIGURE 

ADDITIONAL CLIENTS, GO TO CHAPTER 7: 

ADDITIONAL CLIENT INSTALLS AND 

CONFIGURATIONS AND COMPLETE PHASE 4. 

IF YOU DON’T NEED TO INSTALL AND CONFIGURE 

ADDITIONAL CLIENTS, THIS CONCLUDES THE 

ENTIRETY OF THE SETUP REQUIRED TO BEGIN 

USING WINSPC.  FOR INSTRUCTIONS ON 

LAUNCHING AND LOGGING INTO WINSPC, SEE 

APPENDIX F: LAUNCHING AND LOGGING INTO 

WINSPC. 
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APPENDIX D: GRANTING SHARE AND 

SECURITY PERMISSIONS 

This appendix details one method of granting a user or user group 

share permissions to a folder and one method of granting a user or 

user group security permissions to a file or folder.  These methods are 

applicable to both Windows 2003 Server and Windows XP Pro. 

TO GRANT SHARE PERMISSIONS TO A FOLDER 

1. Log into Windows on the computer containing the folder to which 

you want to grant share permissions as an administrator with 

sufficient privileges to grant permissions. 

2. Using Windows Explorer, navigate to and right-click the file or 

folder to which you want to grant share permissions and, from the 

shortcut menu, select Sharing and Security. 

3. On the Sharing tab of the <Folder Name> Properties dialog box 

that is displayed, select the Share this Folder option, if it isn’t 

already selected. 

4. Click the Permissions button. 

5. In the Permissions for <Folder Name> dialog box, click the Add 

button. 

6. In the Select Users, Computers, or Groups dialog box that 

appears, enter the first letter of the user or user group to whom you 

want to grant share permissions and click OK. 

7. If a Multiple Names Found dialog box is displayed, locate and 

double-click the user or user group. 
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8. With the user or user group selected in the Permissions for 

<Folder Name> dialog box, in the bottom pane, single-click the 

Allow check box for the desired permissions. 

9. Click OK. 

10. If you also want to grant security permissions for the folder, click 

the Security tab in the <Folder Name> Properties dialog box 

and, beginning at step 4 below, complete the To Grant Security 

Permissions to a Folder or File procedure. 

11. If you don’t want to grant security permissions for the folder, click 

OK in the <Folder Name> Properties dialog box. 

TO GRANT SECURITY PERMISSIONS TO A FOLDER OR FILE 

1. Log into Windows on the computer containing the folder or file to 

which you want to grant security permissions as an administrator 

with sufficient privileges to grant permissions. 

2. Using Windows Explorer, navigate to and right-click the folder or 

file to which you want to grant security permissions and, from the 

shortcut menu, select Properties. 

3. In the <Folder Name> Properties dialog box that is displayed, 

click the Security tab. 

4. On the Security tab, click the Add button. 

5. In the Select Users, Computers, or Groups dialog box that 

appears, enter the first letter of the user or user group to whom you 

want to grant security permissions and click OK. 

6. If a Multiple Names Found dialog box is displayed, locate and 

double-click the user or user group. 
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7. With the user or user group selected in the top pane of the Security 

tab, single-click the Allow check box for the desired permissions 

in the bottom pane. 

8. If it is a folder to which you’ve just granted security permissions 

and you need to propagate those permissions to the folder’s child 

folders and files: 

a. On the Security tab, with the user or user group still selected, 

click the Advanced button. 

b. Check the check box labeled Replace permission entries on 

all child objects with entries shown here that apply to child 

objects. 

c. Click Apply. 

d. In the Security warning that is displayed, click Yes.  This 

initiates the propagation of permissions to child folders and 

files. 

e. When the propagation completes, click the Advanced Security 

Settings for <Folder Name> dialog box’s OK button.  

9. Click OK in the <Folder Name> Properties dialog box. 

THIS COMPLETES APPENDIX D. 

RETURN TO AND COMPLETE THE PROCEDURE 

YOU WERE WORKING ON PRIOR TO COMING TO 

THIS APPENDIX. 
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APPENDIX E: ADDING USERS TO A USER 

GROUP 

This appendix details one method of adding users to a user group on a 

domain controller.  It applies to Windows 2003 Server. 

1. On your domain controller, click Start > Administrative Tools > 

Active Directory Users and Computers. 

2. In the left pane of the Active Directory Users and Computers 

dialog box that appears, expand the node for the domain used for 

your WinSPC implementation. 

3. Single-click Users. 

4. In the right pane: 

a. Multi-select all users who will run WinSPC and all local 

administrators who will install and configure WinSPC. 

b. Right-click any of the selected users and, from the shortcut 

menu, select Add to a group. 

5. In the Select Group dialog box, enter the first letter of the user 

group to which you want to add the users and click OK. 

6. If a Multiple Names Found dialog box appears, double-click the 

user group. 

7. In the message indicating that the Add to Group operation was 

successfully completed, click OK. 

8. Close the Active Directory Users and Computers dialog box. 
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THIS COMPLETES APPENDIX E. 

GO TO CHAPTER 7: ADDITIONAL CLIENT 

INSTALLS AND CONFIGURATIONS AND 

COMPLETE PHASE 4. 

IF YOU DON’T NEED TO INSTALL AND 

CONFIGURE ADDITIONAL CLIENTS, THIS 

CONCLUDES THE ENTIRETY OF THE SETUP 

REQUIRED TO BEGIN USING WINSPC.  FOR 

INSTRUCTIONS ON LAUNCHING AND LOGGING 

INTO WINSPC, SEE APPENDIX F: LAUNCHING 

AND LOGGING INTO WINSPC. 
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APPENDIX F: LAUNCHING AND LOGGING 

INTO WINSPC 

If you are launching WinSPC in a Microsoft Terminal Services 

environment, connect to the Microsoft Terminal Services server using 

Remote Desktop before beginning this procedure. 

1. From the client machine, run WinSPC.  The default path for doing 

this is Start > All Programs > WinSPC > WinSPC CS.  

2. In the WinSPC C/S Access Center that is displayed: 

a. At User Name, enter a valid user name   

NOTE: If this is the first time WinSPC is being logged into, 

the only valid user name is Admin. 

b. At Password, enter the password associated with the user 

name entered above. 

NOTE: The password for the Admin user is the password 

created in step 6 of Chapter 6: First Client 

Configuration (Final Steps). 

c. Click Log In. 
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d. If a message appears indicating that you have one or more 

unread messages, click OK. 

NOTE: For help on using WinSPC, see WinSPC’s context sensitive 

Help system.  This Help system can be accessed from within 

WinSPC by clicking a Help button wherever one appears, 

pressing the F1 key or selecting Contents from the Help 

menu. 

 THIS COMPLETES APPENDIX F. 
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APPENDIX G: HARDWARE REQUIREMENTS 

AND RECOMMENDED 

PLATFORMS  

This appendix is provided to assist companies in the selection of 

hardware, operating systems and a database server for their WinSPC 

implementation.  It consists of two sections, one for each of the 

architectures that can be adopted for WinSPC.  These architectures 

are: 

� Conventional Client/Server Architecture 

� Microsoft Terminal Services Architecture 

NOTE: The absence of an operating system or database server from 

any of the below lists means that operating system or 

database server is not tested in DataNet Quality Systems’ lab.  

It does not mean that the operating system or database server 

is known to be incompatible with WinSPC or that DataNet 

Quality Systems will not do its best to support 

implementations using the operating system or database 

server. 
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CONVENTIONAL CLIENT/SERVER ARCHITECTURE 

Minimum Hardware Requirements 

Client Stations Database Server 

� PC with Pentium II Class processor - 

500MHz 

� 512 MB RAM for a typical Windows 

Vista Business station* 

� 256 MB RAM for a typical Windows 

XP Pro or Windows 2000 Pro 

station* 

� 200MB available local hard disk 

space (beyond operating system 

recommended space) 

� VGA monitor and video adapter 

� Keyboard 

� Mouse or other pointing device 

� CD-ROM or DVD-ROM drive (if 

installing WinSPC from the WinSPC 

CD as opposed to the web download) 

 

* By typical is meant a default 

operating system install and no other 

heavy RAM-consuming applications 

running. 

� Server Class processor – 

800MHz 

� 512MB available RAM  

� 10GB available local hard disk 

space (beyond operating 

system recommended space) 

� VGA monitor and video 

adapter 

� Keyboard 

� Mouse or other pointing device 

� CD-ROM or DVD-ROM drive 

NOTE: For a method to estimate 

database storage needs 

based on data specific to 

your company, see the 

How to Estimate 

Database Storage 

Requirements section at 

the end of this appendix. 
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Recommended Platforms 

Server Operating System Database Server Client Operating System 

Windows 2000 Server InterBase 6 Windows 2000 Pro 

Windows 2000 Server InterBase 6 Windows XP Pro 

Windows 2000 Server Microsoft SQL Server 2000 Windows 2000 Pro 

Windows 2000 Server Microsoft SQL Server 2000 Windows XP Pro 

Windows 2000 Server Microsoft SQL Server 2005 Windows 2000 Pro 

Windows 2000 Server Microsoft SQL Server 2005 Windows XP Pro 

Windows 2000 Server Oracle9i Database Windows 2000 Pro 

Windows 2000 Server Oracle9i Database Windows XP Pro 

Windows 2000 Server Oracle Database 10g Windows 2000 Pro 

Windows 2000 Server Oracle Database 10g Windows XP Pro 

Windows 2003 Server InterBase 6 Windows 2000 Pro 

Windows 2003 Server InterBase 6 Windows XP Pro 

Windows 2003 Server Microsoft SQL Server 2000 Windows 2000 Pro 

Windows 2003 Server Microsoft SQL Server 2000 Windows XP Pro 

Windows 2003 Server Microsoft SQL Server 2005 Windows 2000 Pro 

Windows 2003 Server Microsoft SQL Server 2005 Windows XP Pro 

Windows 2003 Server Microsoft SQL Server 2005 

Express 

Windows XP Pro 

Windows 2003 Server Oracle9i Database Windows 2000 Pro 

Windows 2003 Server Oracle9i Database Windows XP Pro 

Windows 2003 Server Oracle Database 10g Windows 2000 Pro 

Windows 2003 Server Oracle Database 10g Windows XP Pro 

Windows 2003 Server Microsoft SQL Server 2005 Windows Vista Business 

Windows 2003 Server Oracle Database 10g Windows Vista Business 

 



Appendix G: Hardware Requirements and Recommended Platforms 

218 Installation and Configuration Guide 

TERMINAL SERVICES ARCHITECTURE 

Minimum Hardware Requirements 

Same minimum client station and database server requirements as for 

Conventional Client/Server Architectures.   

For the Microsoft Terminal Services Server itself, the primary limiting 

factor is RAM.  Approximately 25MB of RAM are consumed by each 

Remote Desktop launch of WinSPC.  If a Microsoft Terminal Services 

server has 2GB of available RAM, then, it could potentially host 80 

simultaneous user sessions.  Additional sessions could be hosted by 

increasing RAM or using server clusters.   

Beyond RAM, the minimum hardware requirements for the Microsoft 

Terminal Services server are: 

� Server Class processor – 800MHz 

� 200MB available local hard disk space (beyond operating system 

recommended space) 

� VGA monitor and video adapter 

� Keyboard 

� Mouse or other pointing device 

� CD-ROM or DVD-ROM drive 

NOTE:  One matter that bears mention but doesn’t qualify as a minimum 

requirement is the Microsoft Terminal Services server’s number of 

CPU cores.  It is possible that, even with sufficient RAM, server 

performance could degrade unacceptably once a certain volume of 

simultaneous sessions is reached.  It isn’t practical to state what 

this volume is because it depends in part on how active those 

sessions are.  A reasonable starting allowance would be 10 

sessions for each CPU core. 
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Recommended Platforms 

The operating system for the Microsoft Terminal Services server must 

be Windows 2003 Server (with Service Pack 1) or newer.  Other than 

this, the recommended platforms for a Microsoft Terminal Services 

architecture are the same as those listed above for a conventional 

client/server architecture.   

HOW TO ESTIMATE DATABASE STORAGE REQUIREMENTS 

This estimation procedure applies equally to conventional client/server 

and Microsoft Terminal Services architectures. 

1. Multiply the average subgroup size by 37.  (E.g. 5x37=185) 

2. Multiply the average percentage of subgroups in violation by 66.  

(E.g. 2%x66=1.32) 

3. Multiply the average number of tag values per subgroup by 17.4.  

(E.g. 4x17.4=69.6) 

4. Add the products from the above three steps.  (E.g. 

185+1.32+69.6=255.92) 

5. Add 141.88 to the sum from step 4. (E.g. 141.88+255.92=397.80) 

6. Multiply the sum from step 5 by the average number of subgroups 

collected per day.  (E.g. 397.80x10,000=3,978,000) 

7. Divide the product from step 6 by 1,000,000.  (E.g. 

3,978,000/1,000,000=3.978.) 

The answer you get from step 7 is the number of MB of disk space you 

can expect to be consumed per day of WinSPC operation. 

 THIS COMPLETES APPENDIX G. 
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APPENDIX H:  SPECIAL CONSIDERATIONS 

REGARDING VISTA BUSINESS  

By taking three considerations into account, WinSPC can be deployed 

and fully used on client stations running Microsoft’s Vista Business 

operating system.  The first consideration concerns User Account 

Control and affects all Vista Business stations.  The second 

consideration concerns archives and, similarly, applies to all Vista 

Business stations.  The third consideration concerns database server 

connections and affects only implementations consisting of a 

Microsoft SQL Server 2005 database server on a Windows 2003 

Server. 

CONSIDERATION REGARDING USER ACCOUNT CONTROL (UAC) 

UAC is a security control in Vista Business.  When enabled, it 

precludes WinSPC users from: 

� Upgrading WinSPC. 

� Exporting text files of data or specifications. 

� Installing Custom Web Reporter. 

� Collecting data from an OPC server when that server is running on 

a computer different from the WinSPC client using it to collect 

data and the WinSPC client has the Use Data Advise option 

enabled.   

To be able to perform these functions, with the exception of the final 

one, UAC must be disabled.  For the final function, while disabling 

UAC certainly permits it to be performed, it is also possible that your 

network administrator, depending on your network security, may be 

able to configure DCOM settings on your client and OPC server so 

that it can be performed with UAC enabled. 
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The procedure for disabling UAC is:  

1. Log into the Vista Business client station as a local administrator. 

2. From the Control Panel click User Accounts. 

3. In the User Accounts window that appears, click Turn User 

Account Control on or off. 

4. If a Windows needs your permission to continue message 

appears, click the Continue button. 

5. In the Turn User Account Control On or Off dialog box, 

uncheck the Use User Account Control (UAC) to help protect 

your computer check box. 

6. Click OK. 

7. When the message indicating your computer must be restarted, 

click Restart Now. 

CONSIDERATION REGARDING ARCHIVES 

In order to archive WinSPC data and cleanly perform other archive-

related tasks on a Vista Business client, a BDE Administrator setting 

must be modified.  To do this: 

1. Log into the Vista Business client as an administrator.  If you are 

already logged in as an administrator, ensure WinSPC is not 

running. 

2. From the Control Panel, launch BDE Administrator. 

3. In BDE Administrator, in the Configuration tab’s Drivers and 

System pane (the left pane), click Configuration > Drivers > 

Native > PARADOX. 
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4. In the Definition pane (the right pane), at NET DIR, replace the 

path displayed with the path to the WinSPC program files, the 

default location for which is C:\Program Files\DQS\WinSPC. 

5. From the Object menu, click Apply. 

6. In the Warning that appears instructing that all BDE applications 

must be restarted in order for the changes to take effect, click OK. 

Whether or not UAC is enabled, a Vista Business client station with 

the NET DIR setting modified as instructed above will be able to 

archive WinSPC data and perform archive-related tasks. 

CONSIDERATION REGARDING MICROSOFT SQL SERVER 2005 

DATABASE SERVER ON WINDOWS 2003 SERVER 

When a WinSPC client running Vista Business connects to a Microsoft 

SQL Server 2005 database server and that database server is running 

on a Windows 2003 Server operating system, WinSPC may on 

occasion display the following error:  

General SQL error.  Possible network error.  Write to SQL Server 

failed.  General network error.  Check your documentation. 

Modifying a particular registry key resolves this issue. 

WARNING: Please consult your network administrator prior to 

completing the below procedure.  Modifying the 

registry key referred to disables one of Windows Server 

2003’s security measures. 

1. Log into Windows Server 2003 as an administrator. 

2. Using the Regedit utility, Navigate to the following registry key: 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Ser

vices\Tcpip\Parameters. 
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3. To this key, add the following DWORD value: 

� Name: SynAttackProtect 

� Value: 0 

4. Restart the Windows 2003 Server machine. 

 THIS COMPLETES APPENDIX H. 


